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About This Guide

Best Practice Deployments

To create a production-viable, best practice ESN deployment, complete the sections below in the 
order presented. 

 Chapter 1, “Overview,” on page 9

 Chapter 2, “Planning Is Critical,” on page 11

 Chapter 3, “System Requirements,” on page 13

 Chapter 4, “Setting Up Shared Storage,” on page 21

 Chapter 5, “Downloading and Preparing the ESN Software,” on page 25

 Chapter 6, “Deploying the Virtual Machines,” on page 29

 Chapter 7, “Starting and Configuring the Appliances,” on page 43

 Chapter 8, “Creating an Expandable ESN Deployment,” on page 49

 Chapter 9, “Setting Up ESN Services,” on page 65

Test and Evaluation Deployments

To create an evaluation or test deployment, see the following sections.

 Appendix A, “Creating an All-in-one (Small) Deployment,” on page 91

and

 Appendix B, “Creating a Non-Expandable Deployment,” on page 93

Upgrade Instructions 

To upgrade an existing deployment, see

 Chapter 11, “Upgrading ESN,” on page 79

Audience

This guide is intended for ESN Administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the comment on this topic link at the bottom of each page of 
the online documentation.

Documentation Updates

For the most recent version of this guide, visit the ESN 1.0 Documentation web site (http://
www.novell.com/documentation/filr-3).
About This Guide 7
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Additional Documentation

For other documentation on ESN 1.0, see the ESN 1.0 Documentation web site (http://
www.novell.com/documentation/filr-3).
8 About This Guide
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1 1Overview

What Is Micro Focus ESN?

Micro Focus ESN is an enterprise file sharing tool that leverages your current file server and security 
infrastructure to provide multi-device access to organizational and personal files.

For more detail about this illustration and for more illustrations and explanations, see the ESN 1.0: 
Understanding How ESN Works.

What Is “ESN Clustering”?

“ESN clustering” is a term that is sometimes used in the ESN product and means that multiple ESN 
appliances access a shared storage location, which contains deployment-level configuration settings 
and data. “ESN clustering” provides a measure of

 Fault tolerance 

And 

 High availability

“ESN clustering” is not related to Novell Cluster Services. 

This guide refers to “ESN-clustered” deployments as “Expandable” deployments.

eDirectory
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FirewallFilr Access
Devices

My Files

Net Folders

Search

Synchronization

Sharing

Filr

NetWare

Windows

w

OES

SharePoint

Filr Data Disk

Comments

External
Users

Other 
Internal
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2 2Planning Is Critical

Creating a successful ESN deployment requires that you 

1. Involve pertinent stakeholders.

2. Conduct a thorough needs assessment.

3. Plan your deployment based on the needs assessment. 

The instructions that follow assume that you have:

1. Completed the planning processes outlined in the ESN 1.0 Planning Your ESN Deployment—
Best Practices guide.

2. Filled in the ESN 1.0 Planning Worksheets associated with the Planning Best Practices guide. 
Planning Is Critical 11
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3 3System Requirements

Expandable Deployments Are the Focus of This Guide

Other deployment types are covered in 

 Appendix A, “Creating an All-in-one (Small) Deployment,” on page 91

 Appendix B, “Creating a Non-Expandable Deployment,” on page 93.

The following sections outline platform, version, and other requirements for your expandable ESN 
deployment. 

 “Administrative Workstations and Browsers” on page 13

 “Appliance Disk Space” on page 13

 “Appliance Memory and CPU” on page 14

 “Appliance Shared Storage (/vashare Mount Point) Platforms” on page 14

 “Desktop Platforms (for the Desktop Application)” on page 15

 “Desktop Web Application Access” on page 15

 “File Servers (Backend Storage)” on page 17

 “ESN Software” on page 17

 “IP Addresses” on page 17

 “LDAP Directory Services (Users and Groups)” on page 19

 “Mobile Device Platforms” on page 19

 “SQL Database Server” on page 20

 “Virtualization Hypervisor Platform” on page 20

Administrative Workstations and Browsers

Table 3-1   Administrative Workstations and Browsers

Appliance Disk Space

 See Worksheet 25—Storage Planning Summary

Planning for disk space varies widely according to organization needs and the planning process is 
covered in the ESN 1.0 Planning Your ESN Deployment—Best Practices guide. 

Platform Browser Requirement

Windows, Mac, or Linux

Capable of running a listed browser

Mozilla Firefox Latest version

Microsoft Internet Explorer 11

Microsoft Edge Latest version

Chrome Latest version

Safari Latest version
System Requirements 13
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General guidelines are summarized in the following sections of the Planning Best Practices guide:

 ESN Appliance Sizing Guidelines

 ESNsearch Appliance Sizing Guidelines

 SQL Server Sizing Guidelines

For an overview of ESN storage, see “Appliance Storage Illustrated” in the ESN 1.0: Understanding 
How ESN Works.

Appliance Shared Storage (/vashare Mount Point) Platforms

 See Worksheet 25—Storage Planning Summary

The ESN appliances in an Expandable deployment access a commonly-shared CIFS or NFS storage 
disk that you will identify and create in Chapter 4, “Setting Up Shared Storage,” on page 21.

Table 3-2   Shared Storage Platforms (/vashare Mount Point)

Appliance Memory and CPU

Table 3-3   Memory and CPU

Protocol Requirement

CIFS  A Windows-based CIFS share

NFS Exported mount point on one of the following:

 SLES 11 SP4

 SLES 12

NFS on Windows is not supported.

Appliance Recommended Minimum

ESN  12 GB RAM

2 GB Operating System

10 GB Java Heap

 4 CPUs

 8 GB RAM

1.5 GB Operating System

6.5 GB Java Heap

 4 CPUs

ESNsearch Less than 1,000 Users

 8 GB RAM

 2 CPUs

More than 1,000 Users

 12 GB RAM

 2 CPUs

Same
14 System Requirements
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Desktop Platforms (for the Desktop Application)

For more information about the ESN desktop application, see the Desktop for Windows Quick Start or 
the Desktop for Mac Quick Start.

Table 3-4   Desktop Platforms (Desktop Application)

Desktop Web Application Access

Three components apply:

 A Browser

 Java

 An Office Application

MySQL Less than 1,000 Users

 8 GB RAM

2 GB Operating System

2 GB Memcached

4 GB Java Heap

 2 CPUs

More than 1,000 Users

 12 GB RAM

2 GB Operating System

3 GB Memcached

7 GB Java Heap

 2 CPUs

Same

Platform Versions

Windows IMPORTANT: Always make sure that the latest patches and support packs are installed.

 Windows 7 SP1 (x86 & x64)

 Windows 8.1 (x64 only)

 Windows 10 (x64 only)

Mac IMPORTANT: Always make sure that the latest patches and support packs are installed.

 10.11 (El Capitan)

 10.12 (Sierra)

Appliance Recommended Minimum
System Requirements 15

http://www.novell.com/documentation/filr-3/esn-user-desktop/data/bookinfo.html
http://www.novell.com/documentation/novell-filr-2/filr-2-qs-desktopmac/data/filr-2-qs-desktopmac.html


Table 3-5   Browsers for Web Application Access

Table 3-6   Java for Web Application Functionality

Table 3-7   Office Application for Edit-in-Place Functionality

Platform Requirement

Linux Mozilla Firefox; Google Chrome (latest versions)

Windows Microsoft Edge

Microsoft Internet Explorer 11 

Mozilla Firefox; Google Chrome (latest versions)

Mac Safari; Mozilla Firefox (latest versions)

Version Functionality

Java v1.7.0_72  Editing files with Edit-in-Place as described in 
“Editing Files with Edit-in-Place” in the ESN 1.0: 
Web Application User Guide.

 Uploading folders to ESN as described in 
“Adding Folders” in the ESN 1.0: Web Application 
User Guide.

If the browser does not support HTML 5, 
uploading both files and folders requires this 
version of Java to be installed.

NOTE: OpenOffice and LibreOffice are used synonymously throughout the Micro Focus ESN documentation.

For more information about Edit-in-Place, see “Editing Files with Edit-in-Place” in the ESN 1.0: Web Application 
User Guide:

Linux  OpenOffice.org (latest version)

 LibreOffice (latest version)

Windows  LibreOffice (latest version)

 OpenOffice (latest version)

 MS Office 2013

 MS Office 2010

 MS Office 365

Mac  LibreOffice (latest version)

 OpenOffice (latest version)

 MS Office 2011 for MAC

 MS Office 2013 for MAC

 MS Office 365 for MAC
16 System Requirements



File Servers (Backend Storage)

NOTE: Your organization’s file servers provide the backend storage for Net Folders.

If you use ESN only for user personal storage (My Files), then file servers aren’t required.

Table 3-8   File Servers

ESN Software

You will download and prepare the ESN software in Chapter 5, “Downloading and Preparing the ESN 
Software,” on page 25.

IP Addresses

Each appliance requires the following.

Platform Supported Versions

Windows  Windows 2008 R2 (CIFS)

 Windows 2012 R2 (CIFS)

Windows native DFS-N and DFS-R with replication are supported

OES  OES 11 SP1 (NCP and CIFS)

IMPORTANT: You must apply at least the December 2012 Scheduled 
Maintenance Update, otherwise the NCP server can fail.

 OES 11 SP2 (NCP and CIFS)

 OES 2015 (NCP and CIFS)

 OES 2015 NSS AD (CIFS)

DFS and DST for OES are supported.

Domain Services for Windows (DSfW) is not supported.

NetWare  NetWare 6.5.8

SharePoint  2013

Other In addition to storage that is directly attached to the file servers listed in Net Folders 
can provide access to files that are being stored on any of the following storage 
methods:

 NetApp NAS device

 EMC

 Other Microsoft Active Directory joined NAS devices that support the CIFS 
protocol. 

 Storage Area Network (SAN)
System Requirements 17



Table 3-9   IP Addresses

Component Requirement

IP Address  A static address that is associated with a DNS 
host name.

Example: 192.168.1.61

Network Mask  The appropriate network mask for the IP 
address.

Example: 255.255.255.0

Gateway IP Address  The gateway for the IP address subnet.

Example: 192.168.1.254

DNS Host Name  The DNS name associated with the IP address.

Example: ESN-1.myorg.local

DNS IP Address  Up to three IP addresses of DNS servers for the 
IP address subnet.

Example: 192.168.1.1

NTP IP Address or DNS Name  Up to three IP addresses or DNS names of 
reliable NTP servers used to coordinate time on 
your organization’s network—especially your 
LDAP directory servers.

Example: time.myorg.local

If using VMware, Novell recommends setting up NTP 
in accordance with the VMware best practices 
guidelines (http://kb.vmware.com/selfservice/
microsites/
search.do?language=en_US&cmd=displayKC&extern
alId=1006427).
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LDAP Directory Services (Users and Groups)

Table 3-10   LDAP Directory Services

Mobile Device Platforms

IMPORTANT: Accessing ESN through a web browser on a mobile device is not supported. Instead, 
download the ESN mobile app that is compatible with your mobile device.

For more information about the ESN mobile app, see the Mobile App Quick Start.

Table 3-11   Mobile Devices

Directory Service Platform Version

eDirectory  NetIQ eDirectory 8.8.x.x (8.8.8.3 is recommended).

For more information, see the NetIQ eDirectory 8.8 Documentation website 
(http://www.novell.com/documentation/edir88).

 NetIQ eDirectory version 8.8.x.x on standalone Windows.

IMPORTANT: eDirectory running on Windows servers with file shares is not 
supported.

Active Directory  Windows Server 2008 R2 Active Directory with the latest Service Pack

 Windows Server 2012 R2 Active Directory with the latest Service Pack

For more information, see Windows Server 2008 Active Directory (http://
www.microsoft.com/windowsserver2008/en/us/active-directory.aspx).

Platform Supported Versions

iOS Phones and Tablets  iOS 8.x or later

The native app is available as a free download in 
the Apple App Store.

Android Phones and Tablets  Android phones and tablets for Android 2.3 or 
later

The native app is available as a free download in 
the Google Play App Store, the Amazon 
Appstore for Android, and the Samsung Knox 
Apps store.

Windows Phones

IMPORTANT: Windows tablets are not currently 
supported.

 Windows 8.0 and 8.1

BlackBerry PlayBook and Z10 The native application is available in the BlackBerry 
World app store.

ESN documentation for BlackBerry is the same as for 
Android devices.
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SQL Database Server

Table 3-12   SQL Database Server

Virtualization Hypervisor Platform

Table 3-13   Virtualization Hypervisor Platform

Database Type Supported Versions

MySQL  5.6 on Linux

 5.6.x on Windows

Microsoft SQL  2008 R2 on Windows 2008 R2

 2012 SP2 on Windows 2012 R2

 2014 on Windows 2012 R2

MariaDB  SLES 12

Hypervisor Type Supported Versions

VMware  One of the following VMware host servers for hosting the appliance VMs.

 ESXi 6.0 with the latest update

 ESX 5.5 with the latest update

For the most up-to-date compatibility matrix of supported VMware host servers, see 
the VMware Compatibility Guide (http://www.vmware.com/resources/compatibility/
search.php?deviceCategory=software&testConfig=16) provided by VMware. 

 A VMware vSphere client 5.1.x or later for accessing the host server and the 
appliances for initial configuration.

Not all versions of the vSphere client are compatible with versions of VMware ESX and 
ESXi. See the VMware Product Interoperability Matrixes (http://
partnerweb.vmware.com/comp_guide2/sim/interop_matrix.php) provided by VMware. 

 VMware vMotion is supported when running ESN on VMware ESXi or 5.5 with the 
latest updates

Hyper-V  The following platforms

 Windows 2008 R2 Server (as a Role)

 Hyper-V Server 2012 R2 (Core)

 Hyper-V Manager to deploy, set up, and configure the appliances.

Xen IMPORTANT: Apply all Xen and kernel patches before installing.

 One of the following servers with the Xen packages installed and the Xen bootloader 
running by default.

 SLES 11 SP4, 64-bit

 SLES 12, 64-bit

 Virtual Machine Manager to deploy, set up, and configure the appliances.

Citrix Xen  Citrix XenServer 6.5 and later

 Citrix XenCenter to deploy, set up, and configure the appliances.
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4 4Setting Up Shared Storage

 See Worksheet 25—Storage Planning Summary

Figure 4-1 is the first in a series of illustrations that visually track deployment order. 

Figure 4-1   Export an NFS Directory or Create a CIFS share for the /vashare mount point

Complete the instructions in the section below that applies to the plans you have made on Worksheet 
25:

 “Exporting an NFS Directory for the /vashare Mount Point” on page 21

Or 

 “Creating a CIFS Share for the /vashare Mount Point” on page 22

Exporting an NFS Directory for the /vashare Mount Point

IMPORTANT: ESN does not support remote NFS from a Novell Storage Services (NSS) volume.

If you plan to use a CIFS share for ESN shared storage (/vashare) in Worksheet 25, skip to “Creating 
a CIFS Share for the /vashare Mount Point” on page 22. Otherwise, export an NFS directory on a 
Linux server by doing the following:

Filr Search 2

Filr Search 1

SQL Server

Filr 3

Filr 2

Filr 1

NFS v3 Server CIFS Server

Or

Exported Directory
for /vashare on all

Filr appliances

Set Up NFS or CIFS Shared Storage

.gz.zip Or

download.novell.com
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Table 4-1   Task 1: Exporting an NFS Directory for /vashare

Creating a CIFS Share for the /vashare Mount Point

Table 4-2   Task 1: Creating a CIFS Share for /vashare

Page, Dialog, or Option Do This

1 - Verify that the server has adequate disk space. 

1. Make sure that the Linux server that you are targeting has the available disk 
space you identified in “Recording Your Plan” in the ESN 1.0 Planning Your 
ESN Deployment—Best Practices guide and recorded on Worksheet 25.

If necessary, add disk space to the Linux server. 

1. On the Linux server, launch YaST2.

YaST Control Center 1. In the Network Services section, click NFS Server.

The NFS Server Configuration dialog box displays.

NFS Server 
Configuration

1. Make sure that the NFS Server is set to Start, that Open Port in Firewall is 
selected (running firewall required for option), and that Enable NFSv4 is not 
selected - i.e. NFS v4 is disabled.

2. Click Next.

Directories to Export 1. Click Add Directory.

YaST2 1. Click Browse and choose the directory or share path identified on Worksheet 
25 that has the required disk space. 

You can add a directory name, such as /shared to the path if desired.

IMPORTANT: The directory path must not be located in the /var directory 
structure on the NFS server, as explained in “NFS Mount Point Must Not Point 
to /var on Target Server” in the ESN 1.0 Release Notes.

2. Click OK.

As your first ESN appliance is deployed, a directory named ESN will be created 
within the directory path you have specified.

3. If you added to the directory path, click Yes to confirm directory creation.

4. Leave the asterisk (*) in the Host Wild Card field.

5. Click the Options field to edit it and change the following options:

 ro to rw (read-only to read-write)

 root_squash to no_root_squash.

6. Click OK.

Directories to Export 1. Click Finish.

2. Skip to Chapter 5, “Downloading and Preparing the ESN Software,” on 
page 25.

Page, Dialog, or Option Do This

1 - Verify that the Windows server has adequate disk space. 
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1. Make sure that the Windows server that you are targeting has the available 
disk space you identified in “Recording Your Plan” in the ESN 1.0 Planning 
Your ESN Deployment—Best Practices guide and recorded on Worksheet 25.

If necessary, add disk space to the server. 

2. Open Windows Explorer

Windows Explorer 1. In Windows Explorer, navigate to the folder that you identified on Planning 
Worksheet 25.

This folder will be the shared storage location (/vashare) for ESN.

2. Right-click the folder, then click Properties.

folder Properties 1. Click the Sharing tab.

2. Click Share. 

ESN Sharing 1. Add a user (new or existing) to the list and assign the Read/Write permission 
to the user.

IMPORTANT: You will need the username and password when you select the 
CIFS share while deploying the ESN appliances.

2. Click Share > Done > Close.

Directories to Export 1. Continue with Chapter 5, “Downloading and Preparing the ESN Software,” on 
page 25.

Page, Dialog, or Option Do This
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5 5Downloading and Preparing the ESN 
Software

After planning your deployment and making sure you have the necessary system requirements in 
place, you are ready to download and prepare the ESN software that applies to your virtualization 
platform.

Figure 5-1   Download the ESN Software for your VM platform

 “VMWare” on page 25

 “Hyper-V” on page 26

 “Xen” on page 27

 “Citrix Xen” on page 27

VMWare

1 As planned in Worksheets 21, 22, and 23 download the ESN software shown below to your 
management workstation.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

Filr Search 2

Filr Search 1

SQL Server

.gz.zip Or

download.novell.com

Filr 3

Filr 2

Filr 1

NFS v3 Server CIFS Server

Or

Exported Directory
for /vashare on all

Filr appliances

Download Filr Software
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2 Extract each .ovf.zip file on your management workstation until an ApplianceType-version 
folder appears.

3 Continue with “Deploying a VMware VM” on page 30.

Hyper-V

1 Log in to the Hyper-V host server either locally or from a remote workstation using Remote 
Desktop.

2 As planned in Worksheets 21, 22, and 23 download the ESN software shown below to the 
location where you plan to host your VMs as identified on Planning Worksheet 25.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

3 Extract each .vhd.zip file in the directory where you downloaded it until an ApplianceType-
version.vhd archive file appears.

4 As planned in Worksheets 21, 22, and 23, create a new directory for each virtual machine. 

As a best practice, name these directories with the name that you plan to use for your different 
appliances. 

Consider including information in the names that easily identifies the appliance type and other 
information, such as the IP address.

For example, 

 ESN-1-30-192.168.1.61

 ESN-2-30-192.168.1.62

 ESNsearch-1-30-192.168.1.71

 ESNsearch-2-30-192.168.1.72

5 Move the ESN-version.vhd archive file to the first ESN appliance-type folder and then copy the 
archive file to the remaining ESN appliance type folders.

6 Move the ESNsearch-version.vhd archive file to the first ESNsearch appliance-type folder and 
then copy the archive file to the second ESNsearch folder.

7 (Optional) If you are deploying a MySQL appliance rather than using an in-house SQL server, 
move the mysql-version.vhd archive file to the MySQL appliance folder.

8 Continue with “Deploying a Hyper-V VM” on page 33.

Appliance Type Filename

ESN ESN.x86_64-version.ovf.zip

Search ESNsearch.x86_64-version.ovf.zip

MySQL (only if no in-house SQL server is available) MySQL.x86_64-version.ovf.zip

Appliance Type Filename

ESN ESN.x86_64-version.vhd.zip

Search ESNsearch.x86_64-version.vhd.zip

MySQL (only if no in-house SQL server is available) MySQL.x86_64-version.vhd.zip
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 Xen

1 Log in to the Xen VM host server either locally or from a remote workstation.

If you are connecting from a remote Linux workstation, use the following command:

ssh -X root@host_ip_address

The -X in the command in required for the GUI installation program upon which the steps in this 
section are based.

2 As planned in Worksheets 21, 22, and 23 download the ESN software shown below to the Xen 
VM host server in the location where you plan to host your VMs as identified on Planning 
Worksheet 25.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

3 Untar each *.gz file in the directory where you downloaded it.

You can use the following command to untar the file:

tar -Sxvzf ApplianceType.x86_64-version.xen.tar.gz

An ApplianceType-version directory is created for each appliance type.

4 Copy and rename the ApplianceType directories until you have one directory for each appliance 
that you have planned to deploy. 

Consider including information in the name that easily identifies the appliance, such as the IP 
address. For example: 

1. Rename the ESN-version directory to ESN-30-192.168.1.61.

2. Copy the ESN-30-192.168.1.61 directory and rename it to ESN-30-192.168.1.62, and so 
on until you have the Correct number of ESN appliances you identified in Worksheet 21.

3. In a similar manner, copy and rename the ESNsearch-version directory until you have two 
ESNsearch appliances.

4. If you need a MySQL appliance, follow the same methodology.

IMPORTANT: Do not change the names of the .raw or .xenconfig files within the directories 
that you have copied and renamed.

5 Continue with “Deploying a Xen VM” on page 36.

Citrix Xen

1 On a workstation with Citrix XenCenter installed, download the ESN software shown below, as 
planned in Worksheets 21, 22, and 23.

IMPORTANT: Registration with Micro Focus is required to receive an email with a download link.

Appliance Type Filename

ESN ESN.x86_64-version.xen.tar.gz

Search ESNsearch.x86_64-version.xen.tar.gz

MySQL (only if no in-house SQL server is available) MySQL.x86_64-version.xen.tar.gz
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2 Using a program such as 7-Zip, extract each .xva.tar.gz file on your management workstation 
until an ApplianceType-version folder appears.

3 Continue with “Deploying a Citrix Xen VM” on page 39.

Appliance Type Filename

ESN ESN.x86_64-version.xva.tar.gz

Search ESNsearch.x86_64-version.xva.tar.gz

MySQL (only if no in-house SQL server is available) MySQL.x86_64-version.xva.tar.gz
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6 6Deploying the Virtual Machines

After downloading and preparing the ESN software as instructed in Chapter 5, “Downloading and 
Preparing the ESN Software,” on page 25, complete the instructions in the section for your 
virtualization platform.

Figure 6-1   Deploy All VMs

 “Deploying a VMware VM” on page 30

 “Deploying a Hyper-V VM” on page 33

 “Deploying a Xen VM” on page 36

 “Deploying a Citrix Xen VM” on page 39

Filr Search 2

Filr Search 1

SQL Server

.gz.zip Or

download.novell.com

Filr 3

Filr 2

Filr 1

NFS v3 Server CIFS Server

Or

Exported Directory
for /vashare on all

Filr appliances

Deploy All the VMs
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Deploying a VMware VM
Complete the steps in Table 6-1 for each appliance that you planned in the following worksheets:

 Worksheet 21—ESN Appliances

 Worksheet 22—ESNsearch Appliances

 Worksheet 23—SQL Database (if applicable) 

Table 6-1   Deploying a VMware VM

Page, Dialog, or Option Do This

1 - Identifying the appliance. 

1. Referring to the worksheets listed in the introduction, choose an appliance to 
deploy.

IMPORTANT: Your ESN deployment must be set up in the order specified in 
Chapter 8, “Creating an Expandable ESN Deployment,” on page 49.

2 - Launching the vSphere Client, naming the VM, and choosing the 
datastore. 

vSphere Client 1. On your management workstation, start the vSphere Client.

2. Click File > Deploy OVF Template.

Deploy OVF Template 1. Click Browse.

Open 1. For the appliance type you are deploying, navigate to the contents of the 
appropriate folder extracted in Step 2 on page 26.

TIP: Check to be sure that the appliance type matches the worksheet you are 
following. 

2. Select the .ovf file.

3. Click Open.

Deploy OVF Template 1. Click Next > Next.

2. In the Name field, type the name of the appliance as planned on the worksheet 
you are following. For example ESN-30-192.168.1.61.

3. Click Next.

4. Choose the datastore you identified as the Location on VM Host Server on 
Worksheet 25—Storage Planning Summary.

5. Click Next to accept the default for the disk format.

6. Do not select Power on after deployment.

7. Click Finish.

The boot disk is created and the appliance is deployed as specified to this 
point.

3 - Editing the VM settings. 

vSphere Client 1. In the vSphere Client, right-click the VM you just deployed and select Edit 
Settings.

The Virtual Machine Properties dialog displays.
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Virtual Machine 
Properties

1. The ESN VMware VMs ship with Memory and CPU settings that are 
appliance-type appropriate in most circumstances. 

You can adjust them at this point if desired, or you can adjust them later if 
required for performance tuning purposes.

If you increase or decrease server memory for a ESN or ESNsearch 
appliance, you should also modify the Java heap size, as described in 
“Changing JVM Configuration Settings” in the ESN 1.0: Administrative UI 
Reference.

 4 - Adding and configuring disk 2 (/vastorage) 

Virtual Machine 
Properties

1. Click Add.

Add Hardware 1. Select Hard Disk.

2. Click Next.

3. Click Next (create a new virtual disk).

4. Adjust the Disk Size field value specified for disk 2 on this appliance in the 
Worksheet 25—Storage Planning Summary.

5. Under Disk Provisioning, select either: 

 Thick Provision Eager Zeroed

or 

 Support clustering features such as Fault Tolerance

Depending on the VMware version that you are running.

6. Under Location, select Specify a datastore or Datastore cluster

7. Click Browse.

8. Select a datastore

9. Click OK.

10. Click Next.

11. Under Virtual Device Node section, select SCSI (1:0).

12. Under Mode, select Independent and Persistent.

13. Click Next.

14. Click Finish.

 5 - Adding and Configuring disk 3 (/var) 

Virtual Machine 
Properties

1. Click Add.

Page, Dialog, or Option Do This
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Add Hardware 1. Select Hard Disk.

2. Click Next.

3. Click Next (create a new virtual disk).

4. Adjust the Disk Size field value specified for disk 3 on this appliance in the 
Worksheet 25—Storage Planning Summary.

5. Under Disk Provisioning, select either: 

 Thick Provision Eager Zeroed

or 

 Support clustering features such as Fault Tolerance

Depending on the VMware version that you are running.

6. Under Location, select Specify a datastore or Datastore cluster

7. Click Browse.

8. Select a datastore

9. Click OK.

10. Click Next.

11. Under Virtual Device Node section, select SCSI (2:0).

12. Click Next.

13. Click Finish.

14. If you need to add network adapters, continue with 6 - (Optional) Adding a 
Network Adapter. 

Otherwise, click OK, return to the top of Table 6-1, and deploy the next 
appliance you have planned for.

6 - (Optional) Adding a Network Adapter 

You can add a network adapter if your ESN deployment accesses a separate 
network for one or more of the following reasons:

 Appliance administration.

 NFS mount or CIFS access to the /vashare mount point.

 Security of memcached.

IMPORTANT: Bonding or teaming NICs is not supported with ESN.

Virtual Machine 
Properties

1. Click Add.

Add Hardware 1. Select Ethernet Adapter.

2. Click Next.

3. Under Network Connection, select the secondary network associated with 
the ESN installation.

4. Click Next > Finish > OK.

vSphere Client 1. Repeat the steps in this table until all of your planned appliances have been 
deployed, then continue with Chapter 7, “Starting and Configuring the 
Appliances,” on page 43.

Page, Dialog, or Option Do This
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Deploying a Hyper-V VM
Complete the steps in Table 6-2 for each appliance that you planned in the following worksheets:

 Worksheet 21—ESN Appliances

 Worksheet 22—ESNsearch Appliances

 Worksheet 23—SQL Database (if applicable) 

Table 6-2   Deploying a Hyper-V VM

Page, Dialog, or Option Do This

1 - Identifying the appliance. 

1. Referring to the worksheets listed in the introduction, choose an 
appliance to deploy.

IMPORTANT: Your ESN deployment must be set up in the 
order specified in Chapter 8, “Creating an Expandable ESN 
Deployment,” on page 49.

2 - Open Hyper-V Manager. 

Hyper-V Host Server 1. Open the Hyper-V Manager.

3 - Create a new VM. 

Hyper-V Manager 1. In the left pane, right-click the server where you have planned to 
create the new virtual machine, then click New > Virtual 
Machine.

The New Virtual Machine Wizard displays.

2. Click Next.

Specify Name and Location 1. Referring to the appropriate appliance worksheet, specify the 
appliance name. For example, ESN-1-30-192.168.1.61.

2. Click Next.

Specify Generation 1. Make sure that Generation 1 is selected. 

2. Click Next.

4 - Specify memory 

Assign Memory 1. In the Startup RAM field, specify the amount of memory (in MB) 
that you planned on the worksheet for this VM. 

2. Click Next.

5 - Assign network adapter 

Configure Networking 1. On the Configure Networking page, select the networking card 
for this VM, then.

2. Click Next.

6 - Identify the system disk  
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Connect Virtual Hard Disk 1. Select Use an existing virtual hard disk. 

2. Browse to and select the .vhd file in the folder you created for 
this appliance.

3. Click Open.

4. Click Next.

Summary 1. Click Finish.

The VM is created and appears in the list of Virtual Machines.

7 - Specify processors 

Hyper-V Manager 1. In Hyper-V Manager, right-click the VM that you just created.

2. Click Settings.

Processor 1. Click Processor.

2. In the Number of virtual processors field, specify the number 
of processors that you planned on the worksheet for this VM. 

3. Click Next.

8 - Add hard disk 2 (/vastorage). 

Settings for VM on Host Server 1. Under Hardware, select IDE Controller 1

2. Click Hard Drive.

3. Click Add.

A Hard Drive entry is added below the controller.

Hard Drive 1. Under Media, select Virtual hard disk.

2. Click New.

New Virtual Hard Disk Wizard 1. Click Next.

Choose Disk Format 1. Select VHD.

2. Click Next.

Choose Disk Type 1. On the Choose Disk Type page, select Fixed size

2. Click Next.

Specify Name and Location 1. Specify the following:

 Name: A descriptive name for the virtual disk. For 
example, ESN-1-Disk-2.

 Location: Specify the location where you want the virtual 
disk to be located. 

2. Click Next.

Configure Disk 1. Select Create a new blank virtual hard disk.

2. Size: Specify the amount calculated for disk 2 on this appliance 
in the Worksheet 25—Storage Planning Summary.

3. Click Next.

Summary 1. Review the summary information.

2. Click Finish

9 - Add hard disk 3 (/var). 

Page, Dialog, or Option Do This
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Hyper-V Manager 1. In Hyper-V Manager, right-click the VM that you just created.

2. Click Settings.

Settings for VM on Host Server 1. Under Hardware, select SCSI Controller.

2. Click HardDrive.

3. Click Add.

A Hard Drive entry is added below the controller.

Hard Drive 1. Under Media, select Virtual hard disk.

2. Click New.

New Virtual Hard Disk Wizard 1. Click Next.

Choose Disk Format 1. Select VHD.

2. Click Next.

Choose Disk Type 1. On the Choose Disk Type page, select Fixed size

2. Click Next.

Specify Name and Location 1. Specify the following:

 Name: A descriptive name for the virtual disk. For 
example, ESN-1-Disk-3.

 Location: Specify the location where you want the virtual 
disk to be located. 

2. Click Next.

Configure Disk 1. Select Create a new blank virtual hard disk.

2. Size: Specify the amount calculated for disk 3 on this appliance 
in the Worksheet 25—Storage Planning Summary.

3. Click Next.

Summary 1. Review the summary information.

2. Click Finish > OK

10 - (Optional) Add a Network Adapter 

You can add a network adapter if your ESN deployment accesses a 
separate network for one or more of the following reasons:

 Appliance administration.

 NFS mount or CIFS access to the /vashare mount point.

 Security of memcached.

IMPORTANT: Bonding or teaming NICs is not supported with 
ESN.

Hyper-V Manager 1. In Hyper-V Manager, right-click the virtual machine for which 
you want to create an additional NIC, then click Settings.

Settings for VM on Host Server 1. Under Hardware, select Add Hardware.

Add Hardware 1. Click Network Adapter.

2. Click Add.

A Network Adapter entry is added to the hardware list.

Page, Dialog, or Option Do This
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Deploying a Xen VM
Complete the steps in Table 6-3 for each appliance that you planned in the following worksheets:

 Worksheet 21—ESN Appliances

 Worksheet 22—ESNsearch Appliances

 Worksheet 23—SQL Database (if applicable) 

Table 6-3   Deploying a Xen VM

Network Adapter 1. Under Virtual Switch, select the secondary network associated 
with the ESN installation.

2. Specify any other required settings for the new network adapter.

3. Click OK.

Hyper-V Manager 1. Repeat the steps in this table until all of your planned 
appliances have been deployed, then continue with Chapter 7, 
“Starting and Configuring the Appliances,” on page 43.

Page, Dialog, or Option Do This

Page, Dialog, or Option Do This

1 - Before you deploy the first Xen VM. 

1. If you have not already done so, before you begin this process, 
you must set up shared storage for your ESN appliances by 
either: 

 Exporting an NFS directory 

or 

 Creating a CIFS share 

See the “Network-Based Shared Disk Space for /vashare” 
section of Worksheet 25 and complete the instructions in 
Section 4, “Setting Up Shared Storage,” on page 21.

2 - Identifying the appliance. 

1. Referring to the worksheets listed in the introduction, choose an 
appliance to deploy.

IMPORTANT: Your ESN deployment must be set up in the 
order specified in Chapter 8, “Creating an Expandable ESN 
Deployment,” on page 49.

3 - Launch the installer. 

Terminal prompt on Xen VM Host 
Server

1. Run the following command to launch the GUI configuration 
menu:

vm-install

The Create a Virtual Machine wizard is displayed.

Create a Virtual Machine 1. Click Forward.
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Install an Operating System? 1. Select I have a disk or disk image with an installed 
operating system.

2. Click Forward.

Type of Operating System 1. Select SUSE Linux Enterprise Server 11. 

2. Click Forward.

4 - Name the VM. 

Summary 1. Click Name of Virtual Machine.

Name of Virtual Machine 1. In the Name field, type the name of one of the appliances that 
you prepared a directory for in Step 4 on page 27.

For example, ESN-1-30-192.168.1.61.

2. (Optional) In the Description field, type additional information 
about the appliance.

3. Click Apply.

5 - Specify the RAM and Virtual Processors. 

Summary 1. Click Hardware.

Hardware 1. Change the Initial Memory and Maximum Memory specify the 
amount of memory (in MB) that you planned on the worksheet 
for this VM.

2. Change the Virtual Processors setting to the number that you 
planned on the worksheet for this VM.

3. Click Apply.

6 - Configure the boot disk 

Summary 1. Click Disks.

Disks 1. Click the Harddisk button.

Virtual Disk 1. Click the Browse button.

Locate Disk or Disk Image. 1. Navigate to the contents of the folder for the appliance you are 
creating.

2. Select the .raw file.

3. Click Open.

Virtual Disk 1. Click OK.

7 - Configure disk 2 (/vastorage) 

Disks 1. Click the Harddisk button.

Virtual Disk 1. Click the Browse button.

Locate Disk or Disk Image. 1. Select the .raw file.

2. Click Open.

Page, Dialog, or Option Do This
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Virtual Disk 1. Click in the Source field.

2. Press the End key.

3. Use the Backspace key to erase the filename so that the path 
ends with the forward slash (/) that follows the appliance’s folder 
name.

4. Type a disk name that reflects the appliance name and that this 
is disk 2. For example, ESN-192.168.1.61-disk-2.

5. Do not change the Storage Format.

6. Change the Size field value according to the appliance type as 
specified in the Worksheet 25—Storage Planning Summary.

7. Make sure that Create Sparse Image File is selected.

8. Click OK.

8 - Configure disk 3 (/var) 

Disks 1. Click the Harddisk button.

Virtual Disk 1. Click the Browse button.

Locate Disk or Disk Image. 1. Select the .raw file.

2. Click Open.

Virtual Disk 1. Click in the Source field.

2. Press the End key.

3. Use the Backspace key to erase the filename so that the path 
ends with the forward slash (/) that follows the appliance’s folder 
name.

4. Type a disk name that reflects the appliance name and that this 
is disk 3. For example, ESN-192.168.1.61-disk-3.

5. Do not change the Storage Format.

6. Change the Size field value according to the appliance type as 
specified in the Worksheet 25—Storage Planning Summary.

7. Click OK.

Disks 1. Click Apply.

2. If you need to add network adapters, continue with “9 - 
(Optional) Add a Network Adapter”. 

Otherwise, click OK.

The virtual machine is created, the appliance starts, and the 
configuration process begins.

3. Go to Chapter 7, “Starting and Configuring the Appliances,” on 
page 43.

4. After completing the instructions in Chapter 8, return to Table 6-
3 on page 36 to deploy your next appliance.

Page, Dialog, or Option Do This
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Deploying a Citrix Xen VM
Complete the steps in Table 6-4 for each appliance that you planned in the following worksheets:

 Worksheet 21—ESN Appliances

 Worksheet 22—ESNsearch Appliances

 Worksheet 23—SQL Database (if applicable) 

Table 6-4   Deploying a Citrix Xen VM

9 - (Optional) Add a Network Adapter 

You can add a network adapter if your ESN deployment accesses a 
separate network for one or more of the following reasons:

 Appliance administration.

 NFS mount or CIFS access to the /vashare mount point.

 Security of memcached.

IMPORTANT: Bonding or teaming NICs is not supported with 
ESN.

Summary 1. Click Network Adapters.

Network Adapters 1. Click New.

Virtual Network Adapter 1. Specify the settings for the adapter.

2. Click Apply.

Network Adapters 1. Click Apply.

Summary 1. Click OK.

The virtual machine is created, the appliance starts, and the 
configuration process begins. 

2. Go to “4 - Accept the license and specify the keyboard layout.” 
on page 44, then return to Table 6-3 on page 36 to deploy your 
next appliance.

Page, Dialog, or Option Do This

Page, Dialog, or Option Do This

1 - Identify the appliance to deploy. 

1. Referring to the worksheets listed in the introduction, choose an appliance to 
deploy.

IMPORTANT: Your ESN deployment must be set up in the order specified in 
Chapter 8, “Creating an Expandable ESN Deployment,” on page 49.

2 - Launch XenCenter. 

Management 
Workstation

1. Start XenCenter.
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XenCenter 1. Connect to the Citrix XenServer where you planned to deploy ESN in 
Worksheet 23 - VM Host Servers.

2. Right-click the server and select Import.

3 - Import the system disk 

Locate the File you want 
to import

1. Browse to and select the .xva file on your management workstation for the 
appliance type that you are deploying.

2. Click Open.

3. Click Next.

Select the location where 
the imported VM will be 
placed

1. Select the XenServer.

2. Click Next.

Select target storage 1. Select the storage repository for the VM.

2. Click Import.

4 - Select the network adapter 

Select network to 
connect VM

1. Select the virtual network adapter.

2. Click Next.

Review the import 
settings

1. Deselect Start VM(s) after import.

2. Click Finish.

IMPORTANT: Depending on network latency and other factors, it can take a 
while to import the system disk.

5 - Specify Memory 

1. If you need to adjust the memory to the amount of memory that you planned on 
the worksheet for this VM, select the newly created VM selected in the left 
pane.

2. Click the Memory tab.

3. Click Edit, change the setting, and click OK. 

6 - Specify Processors 

1. If you need to adjust the CPUs to the number that you planned on the 
worksheet for this VM, right-click the newly created VM in the left pane. 

2. Select Properties.

3. Click CPU, change the setting, and click OK.

7 - Add Disk 2 (/vastorage) 

1. With the newly created VM selected in the left pane, click the Storage tab.

Virtual Disks 1. Click Add....

Add Virtual Disk 1. Type a disk name that reflects the appliance name and that this is disk 2. For 
example, ESN-1-disk-2.

2. Change the Size field value according to the appliance type as specified in the 
Worksheet 25—Storage Planning Summary.

3. Click Add.

8 - Add Disk 3 (/var) 

Page, Dialog, or Option Do This
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Virtual Disks 1. Click Add....

Add Virtual Disk 1. Type a disk name that reflects the appliance name and that this is disk 3. For 
example, ESN-1-disk-3.

2. Change the Size field value according to the appliance type as specified in the 
Worksheet 25—Storage Planning Summary.

3. Click Add.

9 - (Optional) Add a Network Adapter 

You can add a network adapter if your ESN deployment accesses a separate 
network for one or more of the following reasons:

 Appliance administration.

 NFS mount or CIFS access to the /vashare mount point.

 Security of memcached.

IMPORTANT: Bonding or teaming NICs is not supported with ESN.

1. With the newly created VM selected in the left pane, click the Networking tab.

2. Select the secondary network associated with the ESN installation.. 

XenCenter 1. Repeat the steps in this table until all of your planned appliances have been 
deployed, then continue with Chapter 7, “Starting and Configuring the 
Appliances,” on page 43.

Page, Dialog, or Option Do This
Deploying the Virtual Machines 41



42 Deploying the Virtual Machines



7 7Starting and Configuring the Appliances

After the VMs are deployed with the necessary disks added and other settings adjusted according to 
your plans, it is time to start and configure the appliance software on each appliance. When this step 
is completed, all of the appliances will be running and ready to be deployed as an integrated ESN 
infrastructure.

Figure 7-1   Starting and Configuring the Appliances

Table 7-1   Starting and Configuring the Appliances

Page, Dialog, or Option Do This

NOTE: For Xen, after you have completed the instructions in “Deploying a Xen VM” 
on page 36, skip to “4 - Accept the license and specify the keyboard layout.” in this 
table.

1 - Before you deploy the first VM. 
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Starting and Configuring the Appliances 43



1. If you have not already done so, before you begin this process, you must set 
up shared storage for your ESN appliances by either: 

 Exporting an NFS directory 

or 

 Creating a CIFS share 

See the “Network-Based Shared Disk Space for /vashare” section of 
Worksheet 25 and complete the instructions in Section 4, “Setting Up Shared 
Storage,” on page 21 before continuing.

2 - Select an appliance. 

1. Choose one of the appliances that you deployed in Chapter 6, “Deploying the 
Virtual Machines,” on page 29 and refer to its planning worksheet as you start 
and configure it.

IMPORTANT: You must set up your ESN deployment in the order specified in 
Chapter 8, “Creating an Expandable ESN Deployment,” on page 49.

3 - Start the appliance. 

1. After you have downloaded the ESN software and configured your appliances, 
you must start and configure each appliance in turn.

 VMware: In the vSphere Client, power on the first appliance, then click 
the Console tab. 

 Hyper-V: In Hyper-V Manager, right-click the VM and select Start. 

 Citrix Xen: In XenCenter, right-click the appliance and select Start. 

4 - Accept the license and specify the keyboard layout. 

1. After the appliance boots, the License Agreement screen displays.

License Agreement 1. Select your preferred keyboard layout in the Keyboard Language drop-down.

2. (Optional) use the License Language drop-down to change the license 
language.

3. (Optional) use the Keyboard Language drop-down to change the keyboard 
layout.

4. Accept the license agreement.

Page, Dialog, or Option Do This
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Passwords and Time 
Zone

1. On the configuration page, specify the following information:

IMPORTANT: Keep a confidential record of the passwords you set for the root 
and vaadmin users below.

Root password and confirmation: The root password provides root access 
to the appliance terminal prompt. Do not access appliances as the root user 
unless specifically requested by ESN support personnel.

Vaadmin password and confirmation: The preferred user for accessing the 
appliance as requested by ESN support personnel.

Consider using a different password for each appliance for enhanced security.

NTP Server: The IP address or DNS name of the reliable external Network 
Time Protocol (NTP) server for your network. 

Example: time.example.com.

For the best results, set up NTP in accordance with the VMware best practices 
guidelines (http://kb.vmware.com/selfservice/microsites/
search.do?language=en_US&cmd=displayKC&externalId=1006427).

Region: Your local region.

Time Zone: The time zone of all file servers that ESN will provide access to.

2. Click Next.

Network Settings 1. Specify the following:

Hostname: The fully qualified DNS host name associated with the appliance’s 
static IP address. 

Example: myESN.mynetwork.example.com.

IP Address: The static IP address for the appliance. 

Example: 172.17.2.3.

Network Mask: The network mask associated with the appliance’s IP 
address. 

Example: 255.255.255.0.

Gateway: The IP address of the gateway on the subnet where your ESN 
virtual appliance is located. 

Example: 172.17.2.254.

IMPORTANT: ESN appliances do not tolerate latency and should be installed 
in the same subnet or a near-subnet.

DNS Servers: The IP address of a primary DNS server for your network. 

Example: 172.17.1.1.

Domain Search: The domain that is associated with the ESN host name.

2. Click Next.
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Additional LAN Card 
Configuration

1. (Conditional) If you configured multiple network adapters for this appliance, 
select from the following options, then click Next:

 Do Not Configure: Select this option to configure this network at a later 
time as described in “Changing Network Settings” in the ESN 1.0: 
Administrative UI Reference.

 DHCP Dynamic Address: Select this option to have an IP address 
assigned dynamically on the secondary network.

 Statically Assigned IP Address: Select this option to assign a static IP 
address on the secondary network. Then specify the IP address, network 
mask, and host name.

Data Store Location 1. Hard Disk 2 is automatically detected and the disk designation is displayed in 
the hard drive drop-down. 

Accept the defaults for the other options on this page by clicking Next.

WARNING: If you have not already created additional disks 2 and 3 for each of 
your VMs and prepared a shared storage location for your ESN appliances as 
described in early sections of this guide and in Recording Your Plan in the ESN 
1.0 Planning Your ESN Deployment—Best Practices guide, power off the 
virtual machine and make sure you have the required disk space in place for 
your deployment before proceeding. Otherwise, there is a substantial risk that 
your deployment will not meet your organization’s needs.

Data Log Location 1. Hard Disk 3 is automatically detected and the disk designation is displayed in 
the hard drive drop-down. 

ESN: Accept the defaults for the other options on this page by clicking Next.

ESNsearch and MySQL: Accept the defaults for the other options on this 
page by clicking Configure.

Shared Storage Type 
(ESN only)

1. If you are configuring a ESNsearch or MySQL appliance, this page doesn’t 
appear. Go to “Configuring Password, Time, and Network Settings” on 
page 47.

2. If you are configuring a ESN appliance in an expandable deployment (the 
default for this guide)

a. Select the option for the type of shared storage (Remote NFS or Remote 
CIFS) that you identified and configured in Chapter 4, “Setting Up Shared 
Storage,” on page 21.

b. Click Next and continue with the steps for the page matching your 
selection.

3. If you are configuring a small or non-expandable deployment

a. Select Do Not Configure Shared Storage.

b. Click Next.

c. Go to “Configuring Password, Time, and Network Settings” on page 47.

Page, Dialog, or Option Do This
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Shared Storage NFS 
Location

Referring to the work you did in “Exporting an NFS Directory for the /vashare Mount 
Point” on page 21, do the following:

1. For the NFS Server Hostname field, click Browse and select the NFS server 
that you identified.

2. For the Remote Directory field, click Browse and select the directory that you 
exported.

3. Click Configure.

4. Go to “Configuring Password, Time, and Network Settings” on page 47.

Shared Storage CIFS 
Location

Referring to the work you did in “Creating a CIFS Share for the /vashare Mount 
Point” on page 22, do the following:

1. Type the UNC path to the share that you created.

2. Type the user name of the CIFS user that you identified or created.

3. Type the password of the CIFS user.

4. Click Configure.

Configuring Password, 
Time, and Network 
Settings

1. The settings you have specified are configured, storage is verified, and the 
appliance starts. 

Continue as indicated for your deployment type:

Expandable Deployment: Repeat the above steps starting with “2 - Select an 
appliance.” on page 44 until all of your appliances are started, configured, and 
running. Then go to Chapter 8, “Creating an Expandable ESN Deployment,” on 
page 49.

All-in-one (Small) Deployment: Return to Appendix A, “Creating an All-in-
one (Small) Deployment,” on page 91.

Non-expandable Deployment:  Repeat the above steps starting with “2 - 
Select an appliance.” on page 44 until all of your appliances are started, 
configured, and running. Then return to Appendix B, “Creating a Non-
Expandable Deployment,” on page 93.
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8 8Creating an Expandable ESN 
Deployment

Figure 8-1 illustrates the general order for deploying ESN components. Letters reference brief 
component/process descriptions in the table that follows. 

The first process (shared storage) was completed in Chapter 4, “Setting Up Shared Storage,” on 
page 21 and illustrated in Figure 4-1 on page 21.

The illustrations that follow are to help you track deployment progress.
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Figure 8-1   Creating an Expandable Deployment

Letter Details

Exported NFS Directory or CIFS Share: All of the ESN appliances in an expandable deployment 
share this directory, which stores 

 Mutually accessed configuration files

 Personal storage

 Temporary files used by upload and conversion processes

 HTML renderings
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To create an expandable ESN deployment, complete the following sections in the order presented.

 “Setting Up the SQL Database” on page 51

 “Setting Up Two ESN Search Appliances” on page 54

 “Setting Up the ESN Appliances” on page 56

 “Completing the Expandable ESN Deployment” on page 61

 “Dedicating a ESN Appliance to Indexing and Net Folder Synchronization” on page 63

 “Using the Dedicated ESN Appliance to Complete the Indexing Setup” on page 64

Setting Up the SQL Database
Figure 8-3 illustrates that an SQL database is the second component deployed (after shared storage) 
when creating an expandable ESN deployment.

ESN Software: You download ESN software that you then deploy as a boot/system disk on your VM 
host server.

SQL Database: Each ESN appliance in an expandable deployment accesses the same SQL 
database. If available, an SQL server should be used, but if that is not an option, the MySQL 
appliance can be deployed in its place.

ESNsearch Appliances: Micro Focus best practices require that each ESN cluster be configured 
with two ESNsearch appliances. 

ESN Appliances: By definition, a ESN cluster must contain at least two ESN appliances. Micro 
Focus recommends three ESN appliances with the third appliance dedicated to Net Folder 
synchronization and maintaining the search index. 

Additional ESN Appliances: More ESN appliances can be included as the service load increases. 

Letter Details

B

C

D

E

F
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Figure 8-2   Set Up an SQL Database 

IMPORTANT: As noted elsewhere, Micro Focus recommends using an existing SQL database if one 
is available. 

If you need to use a MySQL appliance, prepare that now by completing the instructions in 
Appendix C, “Configuring the MySQL Appliance to Provide the SQL Database (Alternate Practice),” 
on page 95 and then continue with “Setting Up the ESN Appliances” on page 56.

Prepare your in-house SQL server by completing the steps in one of the following sections: 

 “Configuring a MySQL or MariaDB Server” on page 52

 “Configuring a Microsoft SQL Server” on page 53

Configuring a MySQL or MariaDB Server

IMPORTANT: Do not create the ESN database on your MySQL or MariaDB server manually. 

Let the ESN configuration wizard create the database to ensure the correct configuration.

Filr 3

Filr 2

 Filr 1
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Best Practice
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Table 8-1   Configuring MySQL or MariaDB for ESN

Configuring a Microsoft SQL Server

IMPORTANT: Do not create the ESN database on your MS SQL server manually. 

Let the ESN configuration wizard create the database to ensure the correct configuration.

File Do This

1 - Edit the configuration file. 

MySQL or MariaDB 
server > /etc/my.cnf 
file

1. Edit the file as follows:

[client] 
default-character-set = utf8

[mysqld]
character-set-server = utf8
max_connections = 900
transaction-isolation = READ-COMMITTED
expire_logs_days = 7

The expire_logs_days setting is optional, but is recommended because it 
cleans up mysql-bin-* files. 

Unless this is done regularly, the files will consume significant disk space in the 
vastorage directory.

2. Uncomment the InnoDB tables section. 

3. Increase the buffer pool size to approximately 60 percent of the amount of 
RAM that has been allocated to the dedicated server. 

For example, a dedicated server with 4 GB of RAM should have a buffer pool 
size of 2560 MB, as follows:

innodb_buffer_pool_size = 2560M

4. Identify or create a user account with sufficient rights to create and manage the 
ESN database.

Worksheet 23 1. Record the username and password on Worksheet 23.

2. Continue with “Setting Up Two ESN Search Appliances” on page 54.
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Table 8-2   Configuring Microsoft SQL Server for ESN

Setting Up Two ESN Search Appliances
ESN best practices require that every expandable deployment have two ESNsearch appliances. 
There are no advantages to having more than two.

Best practices allow for operating ESN with one search appliance, but only under special 
circumstances, such as when reindexing is required. One appliance continues to service user 
requests while the other is focused on rebuilding the search index.

Figure 8-3 shows that two ESN Search appliances are the third and fourth components deployed in 
an expandable deployment.

File Do This

1 - Configure the server. 

Server management 
console

1. Enable remote access to the Microsoft SQL database server.

2. Open port 1433 on the Windows firewall where the database server is running.

3. Identify or create a user account that is configured with SQL Server 
Authentication and has sufficient rights to create and manage the ESN 
database.

IMPORTANT: ESN supports only SQL Server Authentication. Windows 
Authentication and Windows Domain User Authentication to Microsoft SQL are 
not supported.

Worksheet 23 1. Record the username and password on Worksheet 23.

Server management 
console

1. Run the following queries against the database:

ALTER DATABASE database-name SET READ_COMMITTED_SNAPSHOT ON         
ALTER DATABASE database-name COLLATE Latin1_General_CI_AS_KS_WS 

2. Continue with “Setting Up Two ESN Search Appliances” on page 54.
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Figure 8-3   Set up Two ESN Search Appliances

Table 8-3   Setting Up the ESNsearch Appliances

Page, Dialog, or Option Do This

1. Open a management browser on your administrative workstation and access 
the Port 9443 Administration Utility on the first ESNsearch appliance using the 
following URL:

https://ESNsearch_IP_Address:9443

Where IP_Address is the IP address of the first ESNsearch appliance.

ESN Search Appliance 
Sign In

1. Log in as the vaadmin user with the password that you set for the appliance in 
“Vaadmin password and confirmation:” on page 45.

ESN Search Tools

1. Click the Configuration button  to launch the ESN Search 
Configuration Wizard. 

ESN Search 
Configuration Wizard

1. Click Next.

2. Type and confirm a password for the Lucene Service User (use the same 
password for both appliances).

Make a note of the password for later.

3. Click Finish.
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Setting Up the ESN Appliances
Figure 8-4 illustrates that the ESN appliances are deployed after all other components are in place. 

Figure 8-4   The ESN Appliances Are Set Up Last

Search Settings 1. Scroll down and click Submit > OK.

1. Repeat the steps in this table for the second ESNsearch appliance, then close 
the browser.

2. Continue with “Setting Up the ESN Appliances” on page 56

Page, Dialog, or Option Do This
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Table 8-4   Logging in and Starting the Configuration Wizard

Figure 8-5   Each ESN Appliance Needs the Database Connection Information

Page, Dialog, or Option Do This

1. Open a management browser on your administrative workstation and access 
the Port 9443 Administration Utility on the first ESN appliance using the 
following URL:

https://ESN_IP_Address:9443

Where IP_Address is the IP address of the first ESN appliance.

ESN Appliance Sign In 1. Log in as the vaadmin user with the password that you set for the appliance in 
“Vaadmin password and confirmation:” on page 45.

ESN Appliance Tools

1. Click the Configuration icon  to launch the ESN Configuration Wizard. 

ESN Configuration 
Wizard

1. Large Deployment is automatically selected.

Click Next. 

SQL
Database
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Table 8-5   Configuring each ESN to connect to the SQL Database

Page, Dialog, or Option Do This

Database 1. Specify the following configuration options for the database:

Database Type: Select the type of database that you prepared in “Setting Up 
the SQL Database” on page 51.

Host Name: The host name or IP address of the database server.

Port: The wizard selects the standard port for the database type. If your server 
communicates using a non-standard port, adjust the number accordingly

Database Name: The name of the database you want the wizard to create 
(first appliance) and then connect to (subsequent appliances).

User Name: The administrative user name you identified in “Setting Up the 
SQL Database” on page 51. 

For the MySQL appliance, the default is ESN. 

Password: The administrative user’s password.

2. Click Next.
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Figure 8-6   Initially, Each ESN Appliance Is Configured to Work with One ESN Search Appliance
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Table 8-6   Specify the First Search Appliance, Locale, and Admin user

Page, Dialog, or Option Do This

Search Appliance 1. Specify the first ESNsearch appliance’s DNS name and Lucene password, 
then click Finish.

IMPORTANT: If you specify the IP address, it must be resolvable to the DNS 
hostname of the search appliance.

2. Click Next.

Default Locale 1. Select a Default Locale.

2. If desired, specify a name other than admin for appliance administration on 
port 8443.

3. Click Finish.

IMPORTANT: Wait for the appliance to start before closing the tab or 
navigating away from the page.

4. When the “Congratulations!” message displays, return to Table 8-4 and deploy 
the next ESN appliance.

5. After all of the ESN appliances are deployed, continue with “Completing the 
Expandable ESN Deployment.”
60 Creating an Expandable ESN Deployment



Completing the Expandable ESN Deployment
Figure 8-7   When One ESN Appliance Is Configured for “ESN Clustering,” All of Them Are
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Table 8-7   Enabling ESN-based Clustering

Figure 8-8   The ESN Appliances Are Individually Configured to Use Both ESNsearch Appliances

Page, Dialog, or Option Do This

Configuration Summary 1. In the Configuration panel, click Clustering.

Clustering 1. Select Enable Clustered Environment.

2. The JVM Route field is used only if you are setting up Apache load balancing, 
and is used to uniquely identify this appliance. In many cases, the hostname 
(automatically supplied) will suffice, but you can customize it if needed.

3. In the Server Address field, make sure that both ESNsearch appliances in 
your deployment are listed. Separate the appliances with a space. Use either 
IP addresses or fully-qualified hostnames to identify the appliances.

4. Click OK.

5. Click Reconfigure ESN Server.

The ESN appliance is reconfigured and restarted.

Subsequently, the configuration is shared by each ESN appliance through the 
/vashare mount point.
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Table 8-8   Configuring High-availability Searching

Dedicating a ESN Appliance to Indexing and Net 
Folder Synchronization

As a best practice, Micro Focus recommends dedicating one ESN appliance to Indexing and Net 
Folder Synchronization, which are very resource-intensive tasks.

Do the following:

 Allow Net Folder Synchronization on only the dedicated appliance: Disable Net Folder 
Synchronization on all other ESN appliances as follows:

1. Access the Port 9443 administration console.

2. Click Net Folders.

3. De-select Allow Synchronization.

4. Repeat on all other ESN appliances except the one you are dedicating to Net Folder 
Synchronization.

Now when a Full synchronization occurs (either as a result of a scheduled or manual 
synchronization), the ESN appliance that you set aside is the one that handles the load. 

NOTE: Just-in-time synchronization (JITS) is unaffected and takes place on whichever ESN 
appliance receives the user request that triggers JITS.

Page, Dialog, or Option Do This

Configuration Summary 1. In the Configuration panel, click Search Appliance.

Search Appliance 1. Click the Configuration Type drop-down list and select High Availability.

2. Type the Lucene service password that you set in Table 8-3 on page 55.

3. Notice that the ESNsearch appliance you configured for this ESN appliance is 
listed under Name. 

Click Add.

New Search Node 1. In the Name: field, type an arbitrary name for the second appliance.

2. In the Host Name: field, type the DNS host name of the other ESNsearch 
appliance.

3. Click OK.

Search Appliance 1. Click OK.

Configuration 1. Click Reconfigure ESN Server.

The appliance is reconfigured and restarted.

However, in contrast with the process in Table 8-7, the Search Appliance 
configuration is not propagated to the other ESN appliances.

2. In the upper-right corner, click Log out.

1. Log in to the next ESN appliance and repeat the steps in this table.

2. When all of the ESN appliances have been configured for high-availability 
searching, continue with Dedicating a ESN Appliance to Indexing and Net 
Folder Synchronization.
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 Use Load Balancing to isolate the dedicated appliance from user requests: When you set 
up load balancing, don’t include the dedicated ESN appliance in the round-robin rotation. 

 Rebuild the search index using the dedicated appliance:  Follow the steps in the next 
section. 

Thereafter, the dedicated appliance will handle all of the re-indexing workload.

Using the Dedicated ESN Appliance to Complete the 
Indexing Setup 

Table 8-9   Index with the Dedicated Appliance

Page, Dialog, or Option Do This

1. Open a management browser on your administrative workstation and access 
the Port 8443 Administration Utility on the Dedicated ESN Appliance using the 
following URL:

https://dedicated_ESN_IP_Address:8443

Where IP_Address is the IP address of the dedicated ESN appliance.

ESN 1.0 Sign In Dialog 1. Log in as user admin with password admin, or with the alternate administrator 
name/password if you specified one for this appliance in Table 8-6 on page 60.

2. When prompted, change the user password.

Product Improvement 
(first login only)

1. Click OK.

ESN Main Window (Web 
access)

1. Click the Admin user name in the upper-right corner.

2. Select Administration Console.

Administration Console 1. Click Index in the left frame.

Search Index 1. Select Re-Index Everything.

2. Under Select the Nodes to Apply Re-Indexing to, select the second, write-
only ESNsearch appliance.

3. Click OK.

Indexing should complete with no errors.

Indexing has finished! 1. Click Close.

Administration Console 1. Click Nodes in the left frame.

Search Nodes 1. Change the User Mode Access option for the second ESNsearch appliance 
to Read and Write.

2. Click Apply > Close.

the dedicated ESN appliance will now handle all of the re-indexing workload.
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9 9Setting Up ESN Services

Complete the following steps to prepare your ESN site and make it available to users.

1 Using the Port 9443 > License dialog, install the same valid license on each ESN appliance in 
your system. 

2 Referring to the Worksheets indicated below, change any ESN infrastructure configuration 
settings that require restarting ESN. 

This prevents interrupting ESN services after users begin accessing ESN services.

3 Referring to the worksheets below, add users and groups to your ESN site and set up the LDAP 
synchronization processes.

Worksheet 13 - Notifications 1. (Optional) Using the Port 9443 > Configuration > 
Outbound E-mail dialog, configure your system for 
integration with an external email system.

2. Using the Port 8443 > System > E-Mail dialog, review the 
default notification settings and make any required 
configuration changes. 

Worksheet 20 - Networking Support 1. Review the settings in the Port 9443 > Firewall dialog and 
make sure that the port and firewall settings on your 
network are configured to support ESN services. 

2. If you are enabling port redirection so that users don’t 
need to include :8443 in ESN requests, configure that 
now.

Path: Port 9443 Appliance Console > Configuration > 
Network

3. If you are using NetIQ Access Manager. 

Path: Port 9443 Appliance Console > Configuration > 
Reverse Proxy

Worksheet 4 - Users and Groups (LDAP 
and Non)

1. Configure your ESN system to connect to an existing 
LDAP source, such as eDirectory or Active Directory, to 
control user access to the system. 

Path: Port 8443 ESN Admin Console > System > LDAP

2. Manually create any non-LDAP users and groups that 
need access to ESN services.

For more information, see “ESN Admin Created Users 
and Groups:” in ESN 1.0: Understanding How ESN 
Works and “the New User button” in the ESN 1.0: 
Administrative UI Reference.

Worksheet 5 - LDAP Synchronization 1. Configure the ESN system to synchronize with your 
LDAP servers.

For assistance, see “LDAP Servers and Synchronization” 
in the ESN 1.0: Administrative UI Reference.
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4 If you want users to be able to share through ESN, you must enable sharing for the ESN system. 

5 if you want users to be able to upload personal files and folders directly to the ESN site, you 
must enable personal storage.

For more information about personal storage, as well as how personal storage relates to users’ 
Home folders, see “Enabling Personal Storage for Users and Groups” in the ESN 1.0: 
Administrative UI Reference.

6 Configure Home Net Folder servers.

If the search context of your LDAP synchronization contains an OES or Windows server that has 
a Home folder attribute associated with at least one user, a Net Folder Server is ready to be 
configured immediately after running the LDAP synchronization process. You need to consider 
the amount of data in users’ Home folder directories when performing an LDAP synchronization. 

The following points are critical to successful Home NF Server creation and the synchronization 
of access privileges.

 Import Both Groups and Users: If you import only LDAP users and not the groups they 
belong to, then file system group permissions won't map to ESN group permissions when 
Net Folders are created. 

 Register User Profiles Automatically (default): If you deselect this option, then users 
won't be created until after they log in. This causes the following issues:

 You must wait until users log in to their home folders before you can configure the 
proxy users and passwords for any HOME Net Folder Servers.

 Net Folder access permissions that key off user-based file system permissions will not 
be set or updated during Net Folder Synchronizations.

 Register Group Profiles Automatically (default): If you deselect this option, groups will 
not be created and Net Folder access permissions that key off group-based file system 
permissions will not be set or updated during Net Folder Synchronizations.

7 Configure Net Folder Servers.

Worksheet 14 - System-Level Sharing 
Settings

1. Configure the system-level share settings. 

For more information about allowing users to share 
documents within ESN, see “Managing Sharing, License 
Terms, and Comments” in the ESN 1.0: Administrative UI 
Reference.

Worksheet 11 - Personal Storage 1. Configure Personal Storage.

For more information about allowing users to share 
documents within ESN, see “Enabling Personal Storage 
for Users and Groups” in the ESN 1.0: Administrative UI 
Reference.

Worksheet 8 - Net Folder Servers 1. Configure Home Net Folder servers.

For more information, see “Creating and Managing Net 
Folder Servers” in the ESN 1.0: Administrative UI 
Reference.
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8 Configure Net Folders. 

Net Folders in ESN provide access to files on your corporate OES, Windows, or NetWare file 
servers by synchronizing file metadata. In essence, a Net Folder is simply a pointer or a 
reference to a specific folder on a specific file server. 

ESN can be configured to index the content of Net Folders to make the content searchable.

For more information about Net Folders, see “Managing Net Folders” the ESN 1.0: 
Administrative UI Reference.

9 Enable additional ESN Users for Administrative Access.

10 (Optional) Allow access to the ESN site through NetIQ Access Manager.

For more information about using NetIQ Access Manager with ESN, see Appendix E, 
“Integrating ESN and NetIQ Access Manager,” on page 99.

IMPORTANT: When you use NetIQ Access Manager with ESN, external users cannot access 
your ESN site. This means that the following features are not functional:

 Users are not able to share with external users, as described in “Sharing with People 
Outside Your Organization” in the ESN 1.0: User Access Guide.

 Users cannot make items accessible to the public, as described in “Making Files Accessible 
to the Public” in the ESN 1.0: User Access Guide.

This means that public users cannot access the ESN site as the Guest user. For more 
information about the Guest user, see “Guest Users:” in ESN 1.0: Understanding How ESN 
Works.

For more information about external users in ESN, see “External, Self-Provisioned Users:” in 
ESN 1.0: Understanding How ESN Works.

11 Configure mobile device access to the ESN site, as described in “Mobile Device Access—
Default Settings” in the ESN 1.0: Administrative UI Reference.

Worksheet 8 - Net Folder Servers

Worksheet 10 - Home Folder Net Folder 
Servers

Worksheet 17 - Net Folder Server 
Synchronization

1. Configure the other Net Folder servers that are identified 
on the worksheet.

For more information, see “Creating and Managing Net 
Folder Servers” in the ESN 1.0: Administrative UI 
Reference.

Worksheet 9 - Net Folders

Worksheet 15 - Net Folder Sharing 
Settings

Worksheet 16 - Net Folder Global 
Settings

Worksheet 18 - Net Folder 
Synchronization

1. Configure the Net Folders that are identified on the 
worksheet.

For more information, see “Managing Net Folders” in the 
ESN 1.0: Administrative UI Reference.

Worksheet 19 - Administrative Access 1. Configure users for administrative access to ESN.

For more information, see “Assigning and Managing Port 
8443 Direct Administrators” in the ESN 1.0: 
Administrative UI Reference.
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12 Configure the ESN desktop application to access files from the ESN site.

For more information about configuring the ESN desktop application, see “Desktop Access—
Default Settings” in the ESN 1.0: Administrative UI Reference.

IMPORTANT: For optimal performance of the ESN system when using the ESN desktop 
application, consider the following: 

 Users should not configure the ESN desktop application to synchronize more than 1,000 
total files, or to synchronize individual files that are larger than 1 GB to their workstations. 
For information about how users can configure the ESN desktop application to synchronize 
files to their workstations, see the Micro Focus ESN 1.0 Desktop Application Guide for 
Windows (https://www.novell.com/documentation/filr-3/esn-user-desktop/data/
bookinfo.html) and the Micro Focus ESN 1.0 Desktop Application Guide for Mac (https://
www.novell.com/documentation/filr-3/esn-user-desktop-mac/data/bookinfo.html).

13 Configure ESN to support WebDAV on a Windows 7 environment, as described in “WebDAV 
Support on Windows 7” in the ESN 1.0: Maintenance Best Practices Guide.

14 If your ESN site needs to support multiple languages, configure the site as described in “UI 
Language” in the ESN 1.0: Administrative UI Reference.

15 After you have completed all of the topics in this list that are relevant to your ESN environment, 
you can invite users to use the ESN site. For information about how to use the ESN site, see 
ESN 1.0: User Access Guide.
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10 10Setting Up Sharing 

Before users can share, they must have sharing enabled for them at the ESN system level, either 
individually or as a member of a group. 

After that, sharing of My Files is enabled by default, but sharing in Net Folders requires additional 
steps.

Use the following sections as a guide through the process of setting up sharing.

 “Enabling Users to Share” on page 69

 “Do Not Enable Sharing for All Internal Users and All External Users” on page 74

 “System-Level Sharing Must Be Configured First” on page 75

 “My Files Sharing Is Automatic” on page 75

 “Net Folder Sharing Must Be Explicitly Allowed At Two Levels” on page 76

Enabling Users to Share
 “Best Practices for Setting Up Sharing” on page 69

 “General Order for Setting Up Sharing” on page 70

 “Enabling Sharing for Specific Net Folders” on page 74

Best Practices for Setting Up Sharing

 Enable Sharing for the ESN System: You must enable the sharing feature before any sharing 
can take place on the ESN system. 

As a best practice, enable sharing in an unrestricted way for those users and groups that will be 
allowed to share. 

 If Needed, Restrict My Files Sharing: Enabling sharing automatically lets all users share files 
in their My Files area, including in their Home folder and in personal storage.

You can restrict My Files sharing on a per-user basis if desired.

 Carefully Restrict Net Folder Sharing: Net Folder sharing must be explicitly allowed for each 
Net Folder. 

IMPORTANT: Make sure that only those who need to share a Net Folder’s contents are granted 
sharing rights on that Net Folder. 

For example, Group A is granted rights to share files in Net Folder A. User A (a member of 
Group A) then shares a file with User B (a member of Group B). Because the file contains 
sensitive information, User A doesn’t grant User B permission to reshare the file. 

As long as User B doesn’t have rights to share files in Net Folder A, there is no problem. 

However, if Group B also has permission to share Net Folder A’s files, then User B can reshare 
the file even though User A assumed otherwise.
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General Order for Setting Up Sharing

When you set up sharing for your ESN site, complete the necessary steps in the following order:

1 Set up sharing for the entire ESN site (as described in “Enabling Sharing in ESN” on page 70).

2 Configure sharing for individual users (as described in “Restricting Personal Storage Sharing” on 
page 73).

After you have enabled sharing for the entire ESN system, you can fine-tune share rights 
throughout the site on the user level. 

For example, if you want only a few groups of users to be allowed to share with external users, 
you first need to enable sharing to external users at the site level. After you have enabled it at 
the site level, you can then remove this ability from the users who you do not want to have this 
ability.

3 Set up sharing for specific Net Folders (as described in “Enabling Sharing for Specific Net 
Folders” on page 74).

Users who are given share rights on a specific Net Folder are able to share files within that Net 
Folder that they have rights to at least view on the file system.

Enabling Sharing in ESN

After you set up sharing for the entire ESN site, all users by default are granted rights to share files in 
the My Files area (this includes files in the Home folder and files in personal storage), with the site-
wide access rights that you specify. If you want only certain users to be allowed to share files from 
their My Files area, you must enable sharing for the entire site as described in this section. Then you 
must restrict sharing privileges at the user level, as described in “Restricting Personal Storage 
Sharing” on page 73.

1 Log in to the ESN site as the ESN administrator.

1a Launch a web browser. 

1b Specify one of the following URLs, depending on whether you are using a secure SSL 
connection:

http://ESN_hostname:8080
https://ESN_hostname:8443

Replace ESN_hostname with the hostname or fully qualified domain name of the ESN server 
that you have set up in DNS.

Depending on how you have configured your ESN system, you might not be required to 
enter the port number in the URL. If you are using NetIQ Access Manager, the ESN login 
screen is not used.

2 Click the admin link in the upper-right corner of the page, then click the Administration Console 

icon . 

3 Under System, click Share Settings.

The Share Settings page is displayed.
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4 Select Allow all users to share with groups that have been imported from LDAP to enable 
users to share with LDAP groups.

If you select this option, groups that were imported from the LDAP directory are displayed in the 
Share with field when users are sharing an item (as described in “Sharing Files and Folders” in 
the ESN 1.0: User Access Guide). All users in the LDAP group then have access to the item that 
was shared.

Enabling Users and Groups for Net Folder Sharing

1 To enable sharing for all internal users on the ESN site, go to the User or Group field, begin 
typing All Internal Users, then select it when it appears in the drop-down list.

or

To enable sharing on a per-user or per-group basis, go to the Select user/group field, begin 
typing the name of the user or group for whom you want to grant share rights, then select the 
name when it appears in the drop-down list.

The Edit Share Rights dialog box is displayed. Select from the following options:

Re-share items: When users share a file or folder, they can give the users they are sharing with 
the ability to re-share the file or folder. The user receiving the share can share the file only if that 
user has been given administrative rights to share the file or folder.

IMPORTANT: When selecting this option, be aware that if one user's access rights to an item 
are removed, it does not remove the access rights of the user with whom the item was re-shared.

For example, suppose User A shares an item with User B and grants re-share rights. User B 
then shares the item with User C. If User A revokes User B's access rights to the item, User C 
continues to have access to the shared item. 

Share with Internal users: Allows users to share items with internal users.

Share with “All Internal Users” group: Allows users to perform a mass share to all internal 
users by sharing with the All Internal Users group.

Share with External users: Allows users to share items with users external to the organization. 

Users external to the organization receive an email notification with a link to the shared item, and 
they can then log in to the ESN site. For more information, see “Sharing with People Outside 
Your Organization” in the ESN 1.0: User Access Guide.

Share with Public: Allows users to make items publicly available. This means that anyone with 
the correct URL to the shared item can access the shared item without logging in to the ESN 
site.
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In addition to selecting this option, you also need to enable Guest access to the ESN site if you 
want to allow users to share items with the public. For information about how to enable Guest 
access to the ESN site, see 

Share using File Link: Allows users to share a link to a file in ESN. Any user with the link can 
then access the file. However, the file is not displayed in the Public area, so users must have 
direct access to the link in order to access the file.

For more information about File Links, see “Distributing a Link to a File” in the ESN 1.0: User 
Access Guide.

2 (Optional) Click the Whitelist / Blacklist tab to configure which email addresses and domains 
users can share with when sharing externally.

The following options are available when configuring a whitelist or blacklist for sharing:

No restrictions: Select this option to disregard any email addresses or domains that might 
already exist in the Email addresses and Domains fields. Selecting this option means that users 
can share with any email address.

Whitelist: Select this option to allow sharing only with email addresses and domains that have 
been specified in the Email addresses and Domains fields.

Blacklist: Select this option to disallow sharing with any email addresses and domains that have 
been specified in the Email addresses and Domains fields.

Email addresses: Click Add, specify the email address that you want to add to the whitelist or 
blacklist, then click OK.

Repeat this process to add multiple email address.

Domains: Click Add, specify the domain that you want to add to the whitelist or blacklist (for 
example, yahoo.com), then click OK.

Repeat this process to add multiple domains.
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Delete shares that don’t meet the criteria: Select this option to delete all existing shares in the 
ESN system that do not match the criteria you set. 

For example, if you selected Blacklist and then specified yahoo.com in the Domains field, 
selecting this option would delete all ESN shares made to Yahoo email addresses.

3 Click OK.

Restricting Personal Storage Sharing

After you have enabled sharing of files for the entire ESN system (as described in “Enabling Sharing 
in ESN” on page 70), you can restrict shared-access right granting on an individual-user basis.

You cannot grant individual users more rights than are currently defined for the site-wide setting.

To restrict share rights for specific users:

1 Log in to the ESN site as the ESN administrator.

1a Launch a web browser. 

1b Specify one of the following URLs, depending on whether you are using a secure SSL 
connection:

http://ESN_hostname:8080
https://ESN_hostname:8443

Replace ESN_hostname with the hostname or fully qualified domain name of the ESN server 
that you have set up in DNS.

Depending on how you have configured your ESN system, you might not be required to 
enter the port number in the URL. If you are using NetIQ Access Manager, the ESN login 
screen is not used.

2 Click the admin link in the upper-right corner of the page, then click the Administration Console 

icon . 

3 Under Management, click Users.

4 Select the users whose sharing rights you want to manage, then click More > Workspace Share 
Rights.
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5 Select the radio button in the Clear column next to the sharing right that you want to remove from 
the user or group, then click OK.

or

If you have already removed a share right and you want to add it again, select the radio button in 
the Allow column next to the sharing right that you want to add to the user or group, then click 
OK.

Enabling Sharing for Specific Net Folders

1 Ensure that you have configured sharing as described in “Enabling Sharing in ESN” on page 70.

2 Configure sharing for the Net Folder as described in ).

Do Not Enable Sharing for All Internal Users and All 
External Users

Prior to the release of ESN 2.0, the documentation stated that enabling sharing for All Internal 
Users and All External Users was an acceptable method of enabling sharing on the system. 

Unfortunately, this shortcut results in significant system overhead and often leads to serious 
performance degradation.

We strongly recommend that you enabling sharing only for specific users and/or groups, as outlined 
in the sections that follow.
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System-Level Sharing Must Be Configured First
The first step in allowing ESN sharing to take place is to list the users and groups who are allowed to 
share in the Share Settings dialog. When you add the user or group, you also specify the upper limits 
of possible sharing rights for them. You can further restrict the rights, but you can’t expand them 
beyond this limit.

Figure 10-1   Setting Up System-Level Sharing Rights

My Files Sharing Is Automatic
After sharing is enabled at the system level for users individually or as members of groups, then if 
those users have personal storage enabled, they can share their files and folders within the 
limitations set for the system. 

Administrators can disable sharing of files and folders in My Files on an individual user basis.

1. Click Share Settings.

Group A2. Begin typing, then select 
a user or group.

3. Select the highest
level of rights that the 
user or group will need in 
Filr, then click OK.
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Figure 10-2   My Files Share Settings

Net Folder Sharing Must Be Explicitly Allowed At Two 
Levels

Before the users or groups listed in the Share Settings dialog can share files and folders in their 
assigned Net Folders, they must have sharing enabled on those Net Folders. 

When enabling Net Folder access for a user or group, a ESN administrator can only assign up to the 
maximum sharing rights that are set at the system level.

In Figure 10-3, user red can only be assigned sharing rights that are allowed at the system level.

System-level share settings 

Internal
Users

External
Users

User Red

Guest
Users

Re-Sharing

Re-Share

determine My Files settings.

File
Link
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Figure 10-3   An Example of Net Folder Sharing

System-level share settings limit the sharing rights 
that can be granted 

to a Net Folder user.

Internal
Users

External
Users

User redapple

Guest Users
(Public)

Re-Sharing

Re-Share

File Link

Files Only

Files & Folders

Available, but not granted
Not available

Not available

Not available
Not available

Available, but not granted

Granted

Granted
Granted

Granted
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11 11Upgrading ESN

Prerequisites and Cautions for Successful Upgrades
Failure to comply with any of the following critical points can result in a non-functional ESN system.

NOTE: As an additional resource to the information in this section, TID 7017288 has a “Pre-Flight 
Checklist” that can help you ensure a successful upgrade.

Critical Points Details

 Additional, unformatted disk space is required.

TIP: After you confirm that the new upgraded 
appliances are providing ESN services as 
expected, you can delete the old appliances and 
reclaim their disk space for other VMs, etc.

 Additional unformatted disk space is required for 
the following:

 System Disk: You deploy a new / system 
(first) disk by using the newly downloaded 
.zip or .gz files.

 /vastorage Disk: You copy the /
vastorage (second) disk and point to it 
when deploying the new (upgraded) 
appliance.

Use the tools provided by your hypervisor to 
copy the disk. 

TIP: Citrix Xen requires “exporting” the 
existing disk to create a copy.

 /var Disk: You create a new /var (third) 
disk of the same size as the current /var 
disk for storing system event log files. 

 /vashare NFS directory or CIFS share: This is 
automatically linked to the upgraded appliance.
Upgrading ESN 79

https://www.novell.com/support/kb/doc.php?id=7017288


 Appliance Upgrade Order must be strictly 
followed

 Successful upgrades require that appliances in 
the ESN infrastructure be upgraded in the order 
of their dependency upon each other, as follows:

1. If you are using a MySQL appliance instead 
of an in-house SQL server, you must 
upgrade that appliance first.

2. Upgrade the ESN Search appliances next, 
one at a time.

WARNING: Attempting to start and 
configure multiple upgraded appliances at 
the same time can cause configuration and 
other problems within the upgraded 
appliances.

3. When the upgraded MySQL and ESN 
search appliances are up and running, 
upgrade the first ESN appliance. Then 
upgrade the additional ESN appliances, one 
at a time.

IMPORTANT: All of the ESN and ESNsearch 
appliances in an expandable deployment must 
be upgraded to the same version. 

 Cross-platform upgrades - Not supported  You can only upgrade within a virtualization 
platform. 

For example, if your original ESN system was 
deployed on VMware, you can upgrade only to 
VMware. 

 Migrating the ESN database to Microsoft SQL as 
part of your upgrade

 Carefully follow the instructions in “Migrating the 
ESN’s MySQL Database to Microsoft SQL” in the 
ESN 1.0: Maintenance Best Practices Guide, 
including running the Post-Migration script.

 Mixed-versions - Not supported  All of the ESN and ESNsearch appliances in an 
expandable deployment must be upgraded to the 
same version. 

 Multiple Network Adapters  Carefully follow the instructions in “Preparing 
Network Interface Controllers to Be Upgraded” 
on page 84, including running the networkprep 
script.

 MySQL Non-standard Port Settings Not Retained  If you use a port other than 3306 for MYSQL 
communications, the setting is not retained.

After the upgrade, you must reset the port for 
each ESN appliance using the Port 9443 
administration utility.

Critical Points Details
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After ensuring that you have met the prerequisites and cautions above, complete the instructions in 
the following sections in order.

 “Understanding the Appliance Upgrade Process” on page 82

 “Planning for ESN 1.0 System Requirements” on page 83

 “Planning When to Upgrade” on page 84

 “Checking the Release Notes” on page 84

 “Downloading and Preparing Software for the Upgrades” on page 84

 “Preparing Network Interface Controllers to Be Upgraded” on page 84

 “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 85

 Non-expandable to expandable - Not supported  If you have a non-expandable deployment, and 
you need an expandable deployment, you must 
install a new system.

Or

 Contact Micro Focus Consulting to assist you 
with the migration.

 OES 11 SP1 target servers must be fully patched.  Ensure that any ESN target servers running OES 
11 SP1 have at least the December 2012 
Scheduled Maintenance Update applied. This 
ensures that the NCP server can keep up with 
ESN service requests.

Failure to update your OES 11 SP1 servers can 
cause the configured eDirectory (LDAP) servers 
to fail.

 Small to Large - Not supported  If you have a small, all-in-one deployment, and 
you need an expandable (or a non-expandable) 
deployment, you must install new appliances.

 Software and hardware requirements  See Chapter 3, “System Requirements,” on 
page 13 and make sure the appliances you are 
upgrading meet the requirements for the new 
version.

 VM Copying - Not Supported  Copying an entire VM is not supported. 

Attempting this causes various problems, 
including the reassignment of the Eth0 interface 
to Eth1. ESN supports only Eth0 as the primary 
network interface.

 Copy only the datastore disk to the new VM 
location, as specified in “Copying Each 
Appliance’s /vastorage Disk (Disk 2)” on page 85.

 VMware Snapshots - Not supported  You must remove all VMware snapshots before 
upgrading.

This ensures that the correct disk file and the 
latest configuration settings are on the /
vastorage disk when it is copied.

Critical Points Details
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 “Upgrading the Appliances in the Correct Order” on page 85

 “Upgrading the VMs” on page 85

 “Performing Post-Upgrade Tasks” on page 87

Understanding the Appliance Upgrade Process
The process of upgrading Micro Focus appliances is illustrated in Figure 11-1 on page 83 and 
consists of

 Installing new appliances to replace the existing ones.

 Applying and linking the existing configuration settings (/vastorage) and data (/vashare) to the 
new appliances.
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Figure 11-1   Overview of Appliance Upgrade Process

Planning for ESN 1.0 System Requirements
Make sure that your upgraded systems meet the requirements found in Chapter 3, “System 
Requirements,” on page 13.

As illustrated in Figure 11-1 on page 83, the only new disk that you manually create for each 
upgraded appliance is Disk 3 (/var). 

 Each System Disk (/): Is created automatically as you deploy the downloaded software and 
requires 20 GB of unallocated disk space on the VM host server.

Existing /vashare
NFS or CIFS

(Filr only)

/vastorage
(Disk 2)

New Appliance 1
Location

New /
(Disk 1)

New Appliance 1

New /var
(Disk 3)

Upgrading an Appliance

4. Start and configure the newly deployed VM with 

4. The appliance system prompts you to confirm that you are upgrading.
After you supply a couple of passwords, the system runs through the
configuration screens automatically and the new appliance is an “upgraded”
version of the old appliance.

E

Existing Appliance 1

/vastorage
(Disk 2)

1. Copy Disk 2 of each existing
appliance to where each
“new appliance” will be deployed.
(For Citrix Xen, you export rather 
than copying.)

B

Important: The order in which you start the appliances during an upgrade is critical. 
If you have a MySQL appliance, it must be started first, then the two search 
appliances, and finally the Filr appliances.  

2. Download a new version of each 
appliance type you are 
upgrading.

A .gz.zip Or

3. For each appliance, deploy a new VM.

    The process varies by virtualization platform,
but in each case it involves the following:

C

●  Adding/creating a new system disk (/) from 
the downloaded .zip or .gz file.

●  Including the copy of the /vashare
disk (Disk 2) in the new appliance configuration.

●  Adding a new /var disk (Disk 3).

●  Specifying the RAM and CPU settings.

●  (Optional) Adding a network adapter
for a secondary subnet.

D
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 Each Disk 2 (/vastorage): Is a copy of the old appliance’s Disk 2 and requires an equivalent 
amount of unallocated disk space on the VM host server.

 Each Disk 3 (/var): Is a new disk that you create manually on the VM host server in conjunction 
with the upgrade process.

Disk space, RAM, and CPU requirements are summarized in the following sections of the Planning 
Best Practices guide:

 ESN Appliance Sizing Guidelines

 ESNsearch Appliance Sizing Guidelines

 SQL Server Sizing Guidelines

Planning When to Upgrade
Your ESN services must be offline from the time that you start the first ESNsearch (or MySQL) 
upgraded appliance until the ESN appliances are upgraded and functioning. 

1 Schedule the upgrade for a block of time that is least disruptive from a production standpoint.

2 Notify ESN users about the upgrade.

Checking the Release Notes
1 Check “Upgrade” in the ESN 1.0 Release Notes before continuing.

Downloading and Preparing Software for the 
Upgrades

1 Download and prepare the software for your virtualization platform just as you would for a new 
installation.

For help with the software download and preparation process, refer to the section for your 
virtualization platform in Chapter 5, “Downloading and Preparing the ESN Software,” on 
page 25.

2 Continue with “Preparing Network Interface Controllers to Be Upgraded” on page 84.

Preparing Network Interface Controllers to Be 
Upgraded

If any of your appliances have two Network Interface Controllers (NICs), you must run a script on 
each appliance that prepares the additional NIC to be upgraded.

1 Download the networkprep.zip file from the ESN software downloads page.

2 Enable SSH on the appliance, as described in “Managing System Services” in the ESN 1.0: 
Administrative UI Reference.

3 Using an SSH client (such as WinSCP), log in to the appliance as the root user.

4 Copy the networkprep.zip file that you downloaded to the /root/ directory on the appliance.

5 Unzip the networkprep.zip file:
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unzip networkprep.zip

The networkprep folder is created.

6 Change to the network prep folder:

cd /root/networkprep

7 Run the script:

sh run-networkprep.sh

8 Close the remote SSH connection to the appliance.

9 Continue with “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 85.

Copying Each Appliance’s /vastorage Disk (Disk 2)
1 Using the tools provided by your hypervisor, copy the /vastorage (second disk) to the location 

where your upgraded appliances will be located.

VMware requires shutting down the appliances before making copies.

2 Continue with “Upgrading the Appliances in the Correct Order” on page 85

Upgrading the Appliances in the Correct Order
Successful upgrades require that appliances in the ESN infrastructure be upgraded separately, and in 
the order of their dependencies upon each other.

1 Prepare a checklist for your appliances in the correct upgrade order: 

 MySQL (if applicable): If you are using a MySQL appliance instead of an in-house SQL 
server, you must upgrade that appliance first.

 ESNsearch: You must upgrade the ESNsearch appliances before the ESN appliances.

 ESN: When the upgraded MySQL and ESNsearch appliances are up and running, upgrade 
the first ESN appliance. Then upgrade the additional ESN appliances, one at a time.

2 If there are things you need to remember about individual appliances, include those reminders in 
the upgrade list.

3 Make sure that you upgrade the appliances one at a time.

Attempting to start and configure appliances simultaneously during an upgrade, can cause 
configuration and other problems.

4 Use the checklist as you complete the steps in “Upgrading the VMs.”

Upgrading the VMs
 “Before You Begin Upgrading” on page 85

 “Upgrading Your VMs” on page 86

Before You Begin Upgrading

 Upgrade the appliances one at a time: Attempting to start and configure multiple upgraded 
appliances at the same time can cause timing, synchronization, and other problems.
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 Make sure everything is ready: Do not begin upgrading your appliances until you have:

 Reviewed the prerequisites and cautions section (page 79)

 Checked “Upgrade Notes” in the ESN 1.0 Release Notes

 Made sure your upgraded system will meet ESN 1.0 System Requirements (page 13)

 Downloaded and prepared the software (page 84)

 Prepared any secondary network cards for upgrading (page 84)

 Copied the /vastorage disk to where the new appliances will be deployed (page 85)

 Prepared a checklist that reflects the order in which you are upgrading the 
appliances (page 85)

Upgrading Your VMs

Do the following:

1 Shut down your existing appliances in the following order: ESN, ESNsearch, MySQL (if 
applicable). 

After all of the existing appliances are shut down, continue with Step 2.

2 Deploy the new/replacement VMs one-at-a-time in the order that you planned in “Upgrading the 
Appliances in the Correct Order” on page 85.

3 Deployment tasks vary, depending on your hypervisor and are similar to the installation 
instructions in Chapter 6, “Deploying the Virtual Machines,” on page 29, with the following 
changes:

3a As you name each new/replacement VM, consider using a name that reflects the name of 
the existing VM and also indicates that the VM is new. (This name is for VM-management 
purposes only and does not impact the DNS name, which is unchanged.)

3b Do not add a new Disk 2 (/vastorage). 

Instead, make sure that you attach to the copied Disk 2 for the VM you are upgrading.

3c Add a new Disk 3 (/var) for the appliance type.

For help, see the guidelines in the Planning Best Practices guide:

 ESN /var disk guidelines

 ESNsearch /var disk guidelines (also applies to the MySQL appliance if used)

3d Make sure the RAM and CPU allocations meet the requirements in the following sections of 
the Planning Best Practices guide:

 ESN Appliance Sizing Guidelines

 ESNsearch Appliance Sizing Guidelines

3e After you start the replacement appliance, you are prompted for the root and vaadmin 
passwords. 

Enter the passwords.

IMPORTANT: If you have removed the gateway address on the appliance you are 
upgrading, you are prompted to enter an address. 

The installation code requires a default gateway value to run. You can remove the address 
information again after the upgrade completes.

3f The appliance automatically configures itself using the information from the copied Disk 2.
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4 When the appliance displays the final screen in the console window, open your management 
browser and log in to the appliance on port 9443.

5 Depending on the appliance type you are upgrading, check the following:

6 When the appliance is running, return to Step 2 on page 86 and upgrade the next appliance in 
your plan (“Upgrading the Appliances in the Correct Order” on page 85).

7 When all of your appliances are running, continue with “Performing Post-Upgrade Tasks.”

Performing Post-Upgrade Tasks
After upgrading to a new version of ESN, you should perform the following tasks to ensure a fully 
functional ESN system:

 “(Optional) Enable Net Folder Sharing” on page 87

 “Re-Enabling SSH on the ESN Search and Database Appliances” on page 88

 “Install Your New ESN License” on page 88

(Optional) Enable Net Folder Sharing

Folder sharing is a new feature in ESN 1.0. 

If you have Net Folders where you want users to be able to share folders as well as files, you must 
grant folder sharing rights using the Recipient can share folders in this Net Folder with: option as 
documented in “Grant Rights dialog ” in the ESN 1.0: Administrative UI Reference.

MySQL (optional) ESNsearch ESN

1. Click the phpMyAdmin icon.

2. Verify that the database is 
populated as expected. 

1. Click the ESNsearch 
configuration icon.

2. Ensure that all of the 
settings are in place as 
expected.

3. If the configuration wizard 
displays, there was a 
problem with the 
configuration. 

Resolve the configuration 
issues, then click Finish to 
reconfigure the system.

1. Click the ESN configuration 
icon.

2. Ensure that all of the 
settings are in place as 
expected.

3. If the configuration wizard 
displays, there was a 
problem with the 
configuration. 

Resolve the configuration 
issues, then click Finish to 
reconfigure the system.

Common configuration issues 
include:

 If your system is not using 
DNS, the most likely 
problem is unresolvable 
DNS names and missing /
etc/hosts entries.

 If the appliance doesn’t have 
access to the database, 
ensure that all of the settings 
are as expected.
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Re-Enabling SSH on the ESN Search and Database 
Appliances

If you enabled SSH on the search or database appliances before upgrading your ESN system, it is 
disabled after upgrading, and you need to re-enable it. For more information about how to enable 
SSH, see “Managing System Services” in the ESN 1.0: Administrative UI Reference.

Install Your New ESN License

Upgraded ESN appliances have a 60-day evaluation license installed. 

To prevent a service interruption, you must install your new license by following the instructions in 
“Installing/Updating the ESN License” in the ESN 1.0: Administrative UI Reference.
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 Appendix H, “Third-Party Materials,” on page 111
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A ACreating an All-in-one (Small) 
Deployment

To create an all-in-one deployment, you install one ESN appliance. By default ESN also includes the 
MySQL database and ESNsearch functions.

Ensuring All-in-One Suitability

With few exceptions, small deployments are only suitable for proof-of-concept deployments, which, 
by definition, do not require extensive planning.

For a production deployment, you should use the ESN 1.0 Planning Your ESN Deployment—Best 
Practices guide and associated planning worksheets to gauge whether a small deployment could 
meet your organization’s production needs. 

The Micro Focus best practice recommendation is always an expandable deployment, which is the 
focus of this guide.

All-in-One System Requirements

Most of the requirements in Chapter 3, “System Requirements,” on page 13 apply to small 
deployments. 

However, minimum RAM and CPU recommendations are increased to handle the database and 
search functions running in addition to ESN.

 12 GB of RAM (16 GB is recommended) 

 4 CPUs. 

80% of the RAM should be dedicated to the Java heap.

For information about adjusting the Java heap settings, see “Changing JVM Configuration Settings” 
in the ESN 1.0: Administrative UI Reference.

All-in-One Deployment

To deploy an all-in-one ESN appliance, complete the instructions in the following sections:

Table A-1   

Section Additional Information

Chapter 5, “Downloading and Preparing the ESN 
Software,” on page 25

You only need to download the ESN software for your 
virtualization platform.

Chapter 6, “Deploying the Virtual Machines,” on 
page 29

Follow the instructions in the section for your 
virtualization platform.

Chapter 7, “Starting and Configuring the Appliances,” 
on page 43

Follow the instructions in the referenced section, then 
continue with
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Setting Up an All-in-One (small) ESN Appliance

Table A-2   Logging in and Setting Up a Small ESN Appliance

Page, Dialog, or Option Do This

1. Open a management browser on your administrative workstation and access 
the Port 9443 Administration Utility on the ESN appliance using the following 
URL:

https://ESN_IP_Address:9443

Where IP_Address is the IP address of the ESN appliance.

ESN Appliance Sign In 1. Log in as the vaadmin user with the password that you set for the appliance in 
“Vaadmin password and confirmation:” on page 45.

ESN Appliance Tools

1. Click the Configuration icon  to launch the ESN Configuration Wizard. 

ESN Configuration 
Wizard

1. Click Next. 

Database 1. Type and confirm a password for the ESN user in the MySQL database.

Default Locale 1. Select your Locale from the dropdown list.

2. Change the Administrator User ID if you want to.

The User ID that you enter is also the password for the initial login for the Port 
8443 administration console. 

3. Click Finish.

4. Do not close or exit the browser page until the warning message disappears. 
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B BCreating a Non-Expandable 
Deployment

The steps required to create a non-expandable ESN deployment are almost identical to those for an 
expandable deployment.

Do the following:

1. Begin with Chapter 2, “Planning Is Critical,” on page 11 and complete all of the instructions that 
apply to your virtualization platform and plans.

2. Skip Chapter 4, “Setting Up Shared Storage,” on page 21.

3. Follow the instructions in the remaining sections as they apply.
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C CConfiguring the MySQL Appliance 
to Provide the SQL Database 
(Alternate Practice)

Figure 8-3 illustrates that the MySQL appliance is configured to recognize the ESN appliances and 
allow them to connect before they are set up and deployed.

Figure C-1   Deploying MySQL

Table C-1   Configuring a MySQL Appliance

Page or Dialog Do This

IMPORTANT: The following steps assume that you installed and prepared a MySQL 
appliance as documented in the previous chapters, in addition to your ESN and 
ESNsearch appliances.

Filr 3

Filr 2

 Filr 1

SQL Database MySQL
Appliance

Filr Search 2

Filr Search 1

NFS v3 Server CIFS Server

Or

Exported Directory
for /vashare on all

Filr appliances

Prepare the MySQL Appliance
(Alternate Practice)

.gz.zip Or

download.novell.com
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1. Using a browser on your management workstation, access the Port 9443 
Administration Utility on the MySQL appliance by entering the following URL:

https://mysql_IP_Address:9443

Where IP_Address is the IP address of the MySQL appliance.

MySQL Appliance Sign 
In

1. Log in as the vaadmin user with the password that you set for the appliance in 
“Vaadmin password and confirmation:” on page 45.

MySQL Tools 1. Click the phpMyAdmin button to launch the phpMyAdmin utility.

2. Log in as root with password root.

phpMyAdmin 1. Under General Settings, click Change Password.

2. Type and retype (confirm) a new password for the phpMyAdmin root user, 
then click Go.

IMPORTANT: If you click the Generate button, the generated password takes 
precedence over your typed passwords. 

Be sure to note the generated password and use it when configuring ESN. 

3. Click the Users tab.

Users Overview 1. Under New, click Add User.

Login Information 1. Type ESN in the User Name field.

TIP: You can specify any name for the user and associated database. If you 
specify a different name, then when you set up the ESN appliances, you will 
need to use that name instead of ESN.

2. For the Host field, select Use Host Table.

3. In the Host field, type the IP addresses for each of the ESN appliances that 
you will configure.

4. In the Password and Re-type fields, type and re-type (confirm) a password for 
the new ESN user, then scroll down. 

IMPORTANT: You will need this password when you configure the ESN 
appliances.

Database for user 1. Select Create database with same name and grant all privileges.

2. In the bottom right corner of the dialog, click Go.

A ESN user entry is added and the corresponding database is created.

Users Overview 1. Notice that the ESN user is listed with the appliances’ IP addresses shown in 
the Host column.

2. Return to “Setting Up the ESN Appliances” on page 56.

Page or Dialog Do This
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D DConfiguring ESN to Work with OES 
2015 NSS AD

Although both ESN 1.0 and OES 2015 NSS AD support SMB v2, ESN configures Net Folder 
connections that point to NSS AD servers to use the SMB v1 protocol.

If you have Net Folder Server connections that point to NSS AD servers, you should change ESN to 
use SMB v2 for the connections by doing the following:

1 Ensure that the OES 2015 NSS AD server has the latest patches applied. 

2 If SSH is not enabled on the ESN appliance, do the following:

2a Log in to the ESN appliance at https://server_url:9443 as the vaadmin user.

2b Click System Services, then click SSH > Action > Start.

3 Using an SSH client, log in to the ESN appliance as the root user.

4 Run the following command:

/opt/novell/ESN/bin/famtconfig -s ncifsSMB 2

5 Restart famtd by running the following command. 

# rcnovell-famtd restart

IMPORTANT: If you do not restart famtd, then the SMB v1 protocol is used for connections 
made prior to doing Step 4.

6 For large, clustered deployments, repeat these steps for all of the ESN servers in the cluster

NOTE: To reset the ESN connections with OES 2015 NSS AD servers from SMB v2 back to SMB v1, 
run the following commands:

/opt/novell/ESN/bin/famtconfig -s ncifsSMB 1

# rcnovell-famtd restart
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E EIntegrating ESN and NetIQ Access 
Manager

 “NetIQ Access Manager” on page 99

 “Caveats for External User Access” on page 100

 “Understanding Reverse Proxy and NetIQ Access Manager” on page 100

 “Configuring a Protected Resource for a Micro Focus ESN Server” on page 101

 “Bypassing NetIQ Access Manager to Log In to ESN and Perform Administrative Tasks” on 
page 106

 “HTTP/HTTPS Ports When You Use NetIQ Access Manager with ESN” on page 106

 “Port Configuration” on page 106

To allow access to the ESN site through NetIQ Access Manager, you need to make configuration 
changes in NetIQ Access Manager to configure a protected resource for a Micro Focus ESN server 
as described in “Configuring a Protected Resource for a Micro Focus ESN Server” on page 101.

NetIQ Access Manager
Using Micro Focus ESN in conjunction with NetIQ Access Manager adds enterprise-level security to 
your ESN system.

Only a version of Access Manager that supports Transport Layer Security (TLS) can be used when 
using Access Manager with ESN. For information about which versions of Access Manager support 
TLS and how to enable it, see Enabling Transport Layer Security 1.1 and 1.2 for Access Manager 
(https://www.netiq.com/documentation/netiqaccessmanager4/enable_tls_nam40/data/
enable_tls_nam40.html#).

IMPORTANT: NetIQ Access Manager cannot grant external users access through the generated 
URL links that ESN includes in email notifications. This means that the following features are not 
functional for external or Guest users:

 Users are not able to share with external users, as described in “Sharing with People Outside 
Your Organization” in the ESN 1.0: User Access Guide.

A possible work-around for this issue is documented in TID 7014912 (https://www.novell.com/
support/kb/doc.php?id=7014912).

 Users are not able to share a File Link with external users, as described in “Distributing a Link to 
a File” in the ESN 1.0: User Access Guide.

 Users cannot make items accessible to the public, as described in “Making Files Accessible to 
the Public” in the ESN 1.0: User Access Guide.

This means that public users cannot access the ESN site as the Guest user. For more 
information about the Guest user, see “Guest Users:” in ESN 1.0: Understanding How ESN 
Works.

For more information about external users in ESN, see “External, Self-Provisioned Users:” in ESN 
1.0: Understanding How ESN Works.
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Before internal users can access your ESN site through NetIQ Access Manger, you must first 
configure specific protected resources in Access Manager to be public, as described in Appendix E, 
“Integrating ESN and NetIQ Access Manager,” on page 99.

Furthermore, you can configure NetIQ Access Manager to work with Micro Focus ESN in the 
following way:

 Configure NetIQ Access Manager to provide single sign-on access to the ESN site.

For more information, see “Reverse Proxy Configuration Settings” in the ESN 1.0: Administrative 
UI Reference.

When you set up NetIQ Access Manager to work with ESN, ensure that you specify the correct 
HTTP/HTTPS port numbers during the configuration of the ESN appliance, as described in “HTTP/
HTTPS Ports When You Use NetIQ Access Manager with ESN” on page 106.

Caveats for External User Access
NetIQ Access Manager cannot grant external users access through the generated URL links that 
ESN includes in email notifications. This means that the following features are not functional for 
external or Guest users:

 Users are not able to share with external users, as described in “Sharing with People Outside 
Your Organization” in the ESN 1.0: User Access Guide.

A possible work-around for this issue is documented in TID 7014912 (https://www.novell.com/
support/kb/doc.php?id=7014912).

 Users are not able to share a File Link with external users, as described in “Distributing a Link to 
a File” in the ESN 1.0: User Access Guide.

 Users cannot make items accessible to the public, as described in “Making Files Accessible to 
the Public” in the ESN 1.0: User Access Guide.

This means that public users cannot access the ESN site as the Guest user. For more 
information about the Guest user, see “Guest Users:” in ESN 1.0: Understanding How ESN 
Works.

For more information about external users in ESN, see “Guest Users:” in ESN 1.0: Understanding 
How ESN Works.

Understanding Reverse Proxy and NetIQ Access 
Manager

NetIQ Access Manager can provide secure single sign-on access to your Micro Focus ESN site by 
functioning as a reverse proxy server. When using Access Manager with Micro Focus ESN, Access 
Manager 4.1.1 or later is required and is an additional add-on product. You can download the 
required version of Access Manager from the NetIQ Downloads site (https://dl.netiq.com/index.jsp).

For background information about setting up NetIQ Access Manager 4.1.1, see the Access Manager 
4.1 Documentation website (https://www.netiq.com/documentation/access-manager-41/). For 
instructions specific to ESN, see “Configuring a Protected Resource for a Micro Focus ESN Server” 
on page 101.
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After you have configured NetIQ Access Manager, you must configure your ESN site with the IP 
address of one or more Access Gateway servers and with the logout URL. When you configure the 
ESN site to use the Access Gateway, the IP addresses that you specify are the only locations from 
which the ESN site accepts logins. The logout URL is the location where users find themselves when 
they log out of the ESN site.

When you enable the Access Gateway for use with your ESN site, all ESN users must log in through 
the Access Gateway. It is not possible to set up the ESN site so that some users log in through the 
Access Gateway and some do not.

Configuring a Protected Resource for a Micro Focus 
ESN Server

The following sections explain how to configure the Access Gateway with a domain-based multi-
homing service. The instructions assume that you have a functioning Micro Focus ESN appliance and 
a functioning Access Manager system (4.1.1 or higher) with a reverse proxy configured for SSL 
communication between the browsers and the Access Gateway.

The ESN server needs to be configured to trust the Access Gateway to allow single sign-on with 
Identity Injection and to provide simultaneous logout. You also need to create an Access Gateway 
proxy service and configure it. 

 “Configuring the Micro Focus ESN Server to Trust the Access Gateway” on page 101

 “Configuring a Reverse-Proxy Single Sign-On Service for Micro Focus ESN” on page 101

Configuring the Micro Focus ESN Server to Trust the 
Access Gateway

To use Micro Focus ESN as a protected resource of an Access Gateway and to use Identity Injection 
for single sign-on, the ESN server needs a trusted relationship with the Access Gateway. With a 
trusted relationship, the ESN server can process the authorization header credentials. The ESN 
server accepts only a simple user name (such as user1) and password in the authorization header.

To configure a trusted relationship and simultaneous logout, specify the reverse proxy configuration 
settings for your ESN appliance, as described in “Reverse Proxy Configuration Settings” in the ESN 
1.0: Administrative UI Reference.

Configuring a Reverse-Proxy Single Sign-On Service for 
Micro Focus ESN

To configure a reverse-proxy single sign-on service for ESN, complete the following tasks:

 “Creating a New Reverse Proxy” on page 102

 “Configuring the Domain-Based Proxy Service” on page 102

 “Creating Policies” on page 102

 “Creating a Word Rewriter Profile for Each ESN Host” on page 104

 “Configuring Protected Resources” on page 104

 “Disabling a Rewriter Profile and Enabling Port Redirection” on page 105
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Creating a New Reverse Proxy

Before you can configure the domain-based proxy service, you need to create a new reverse proxy. 
For information, see “Managing Reverse Proxies and Authentication” in the NetIQ Access Manager 
4.1 Administration Guide.

Configuring the Domain-Based Proxy Service

1 In the Administration Console, click Devices > Access Gateways > Edit, then click the name of 
the reverse proxy that you created in “Creating a New Reverse Proxy” on page 102.

2 Click the reverse proxy link that you have previously created. In the Reverse Proxy List, click 
New, then fill in the following fields:

 Proxy Service Name: Specify a display name for the proxy service that the Administration 
Console uses for its interfaces.

 Published DNS Name: Specify the DNS name that you want the public to use to access 
your site. This DNS name must resolve to the IP address that you set up as the listening 
address. For example, ESN.doc.provo.novell.com.

IMPORTANT: To avoid incomplete logout problems, you must also create a an Additional 
Strings to Replace entry for each ESN appliance that points to this DNS name. 

See “Creating a Word Rewriter Profile for Each ESN Host” on page 104.

 Web Server IP Address: Specify the IP address of the ESN server.

 Host Header: Select the Forward received host name.

 Web Server Host Name: Because of your selection in the Host Header field, this option is 
dimmed.

3 Click OK.

4 Click the newly added proxy service, then select the Web Servers tab.

5 Configure the Connect Port to match the Reverse Proxy Secure HTTP Port setting that you 
configured from the ESN appliance, as described in “Reverse Proxy Configuration Settings” in 
the ESN 1.0: Administrative UI Reference. This will be either port 443 or 8443.

6 When using SSL, select Use SSL in the Access Manager configuration, then select one of the 
following:

 Any in reverse proxy store: Select this option if your ESN and Access Manager servers 
are in separate geographical locations, or if you want added security within your local 
network.

 Do not verify: Select this option if your ESN and Access Manager servers are part of the 
same local network.

7 Click TCP Connect Options.

8 Click OK.

9 Continue with “Configuring Protected Resources” on page 104.

Creating Policies

You need to create two policies: LDAP Identity Injection and X-Forward-Proto:

 “Creating the LDAP Identity Injection Policy” on page 103

 “Creating the X-Forward-Proto HTTP Header Policy” on page 103
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Creating the LDAP Identity Injection Policy

1 In the Administration Console, click Policies > Policies. 

2 Select the policy container, then click New.

3 Specify ldap_auth as the name for the policy, select Access Gateway: Identity Injection for the 
type, then click OK.

4 (Optional) Specify a description for the injection policy. This is useful if you plan to create multiple 
policies to be used by multiple resources.

5 In the Actions section, click New, then select Inject into Authentication Header.

6 Fill in the following fields: 

User Name: If users are provisioned with cn or uid attributes, select Credential Profile, then 
select LDAP Credentials:LDAP User Name. In the Refresh Data Every drop-down, select 
Session.

or

If users are provisioned with mail attributes, select LDAP Attribute, then select mail. In the 
Refresh Data Every drop-down, select Session.

Password: Select Credential Profile, then select LDAP Credentials:LDAP Password.

7 Leave the default value for the Multi-Value Separator, which is comma.

8 Click OK.

9 To save the policy, click OK, then click Apply Changes.

For more information on creating such a policy, see “Configuring an Authentication Header 
Policy” in the .

Creating the X-Forward-Proto HTTP Header Policy

When communicating over HTTPS from the browser to Access Manager, and over HTTP from 
Access Manager to ESN, the X-Forwarded-Proto is a best practice.

1 In the Administration Console, click Policies > Policies. 

2 Select the policy container, then click New.

3 Specify x-forward as the name for the policy, select Access Gateway: Identity Injection for the 
type, then click OK.

4 (Optional) Specify a description for the injection policy. This is useful if you plan to create multiple 
policies to be used by multiple resources.

5 In the Actions section, click New, then select Inject into Custom Header.

6 Fill in the following fields: 

Custom Header Name: Specify X-Forward-Proto as the name.

Value: Select String Constant in the drop-down, then specify https.

7 Leave the other settings at the defaults.

8 Click OK.

9 To save the policy, click OK, then click Apply Changes.

For more information on creating such a policy, see “Configuring an Authentication Header 
Policy” in the .NetIQ Access Manager 4.1 Administration Guide
Integrating ESN and NetIQ Access Manager 103



Creating a Word Rewriter Profile for Each ESN Host

Due to a security fix in ESN 2.0 and later, when users log out of ESN, they are taken to the ESN DNS 
name rather than the NAM host. This results in a condition where it appears that they are logged out 
although they actually are not.

To avoid these incomplete login conditions, create a word rewriter for each ESN host that points to 
the DNS name of the NAM host. 

The NetIQ Access Manager Best Practices Guide contains pertinent rewriter examples in a section 
that deals with SharePoint. See Table 3-2 in the above-mentioned guide and also refer to the 
instructions associated with the table.

Configuring Protected Resources

You need to create two protected resources, one for HTML content and a public protected resource:

1 Create a protected resource for HTML content:

1a In the Protected Resource List, click New, specify Basic auth with redirection for the 
name, then click OK. 

1b (Optional) Specify a description for the protected resource. You can use it to briefly describe 
the purpose for protecting this resource.

1c Click the Edit icon  next to the Authentication Procedure drop-down list. 

1d Create a new authentication procedure by clicking New, specifying a name for the 
authentication procedure, and then clicking OK.

1e In the dialog box that is displayed, fill in the following fields.

Contract: Select the Secure Name/Password - Form contract.

Non-Redirected Login: Select this option.

Realm: Specify a name that you want to use for the ESN server. This name does not 
correspond to a ESN configuration option. It appears when the user is prompted for 
credentials.

Redirect to Identity Server When No Authentication Header is Provided: Select this 
option.

1f Click OK twice.

1g In the URL Path List, add the following paths for HTML content:

/*
/ssf/*
/ssf/s/readFile/share/*

1h On the configuration page for the protected resource, select the authentication procedure 
that you just created from the Authentication Procedure drop-down list, then click OK.

2 Create a public protected resource for Web Services:

NetIQ Access Manager is not designed to protect certain public resources. You must complete 
the following steps to allow these resources to be protected by the ESN server itself, rather than 
by NetIQ Access Manager.

2a In the Protected Resource List, click New, specify public for the name, then click OK.

2b (Optional) Specify a description for the protected resource. You can use it to briefly describe 
the purpose for protecting this resource.

2c For the Authentication Procedure, select None.
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2d Click OK.

2e In the URL Path List, remove the /* path and add the following paths:

For public content:

/ssf/atom/*
/ssf/ical/*
/ssf/ws/*
/ssf/rss/*
/ssr/* 
/rest/*
/rest
/
/dave/*
/my_files/*
/net_folders/*
/shared_with_me
/desktopapp/*

The /ssf/rss/* path enables non-redirected login for RSS reader connections. 

ESN provides authentication for all of the paths listed above.

2f Click OK.

3 Assign the X-Forward-Proto Header policy to both protected resources that you created: 

3a Click Access Gateways > Edit > [Name of Reverse Proxy] > [Name of Proxy Service] > 
Protected Resources.

3b For each ESN protected resource, click the Identity Injection link, select the x-forward 
policy that you created, click Enable, then click OK.

3c Click OK.

4 Assign the Identity Injection policy to the HTML protected resource that you created, specifically, 
Basic auth with redirection.

4a Click Access Gateways > Edit > [Name of Reverse Proxy] > [Name of Proxy Service] > 
Protected Resources.

4b For each ESN protected resource, click the Identity Injection link, select the ldap_auth 
policy that you created, click Enable, then click OK.

4c Click OK.

5 To save the configuration changes, click Devices > Access Gateways, then click Update.

6 In the Protected Resource List, ensure that the protected resources that you created are 
enabled.

7 To apply your changes, click Devices > Access Gateways, then click Update.

8 Continue with “Disabling a Rewriter Profile and Enabling Port Redirection” on page 105.

Disabling a Rewriter Profile and Enabling Port Redirection

NOTE: If you have changed the ESN and Access Manager ports from their defaults (8443 for ESN 
and 443 for Access Manager), you cannot disable the rewriter profile and enable port redirection as 
described in this section. Instead, you must configure a rewriter profile in Access Manager, as 
described in “Creating or Modifying a Rewriter Profile” in the .
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To disable the HTML Rewriter and enable port redirection:

1 In the Proxy Service List in Access Manager, ensure that the HTML Rewriter is disabled.

2 Under the Web Servers tab, ensure that the Connect Port has been modified to port 443. (This 
matches the configuration that you made in Step 5 in “Configuring the Domain-Based Proxy 
Service” on page 102.)

3 Enable port redirection on the ESN server, as described in “Changing Network Settings” in the 
ESN 1.0: Administrative UI Reference. 

This allows ESN to listen on port 8443, and allows Access Manager to forward client requests to 
port 443.

Bypassing NetIQ Access Manager to Log In to ESN 
and Perform Administrative Tasks

To perform administrative tasks on your ESN system, you need to log in to bypass NetIQ Access 
Manager and log in to ESN directly as the ESN administrator.

To allow administrator access to the ESN system when your ESN system is fronted by Access 
Manager:

1 Add another IP address to the Access Gateway address(es) field, as described in “Reverse 
Proxy Configuration Settings” in the ESN 1.0: Administrative UI Reference.

2 Access this IP address that you added in Step 1 at port 8443. For example, 172.17.2.3:8443.

HTTP/HTTPS Ports When You Use NetIQ Access 
Manager with ESN

If you are fronting ESN with NetIQ Access Manager, ensure that you have configured the HTTP/
HTTPS ports.

Configuring ESN in this way configures NetIQ Access Manager to access ESN over port 80, which is 
the standard port.

Port Configuration
Use the following port configuration when NetIQ Access Manager is fronting your ESN system on 
Linux:

 HTTP Port: 80

 Secure HTTP Port: 443

You need to make these configuration settings in the Reverse Proxy section. For more information, 
see “Reverse Proxy Configuration Settings” in the ESN 1.0: Administrative UI Reference.
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F FVMware—Changing the SCSI 
Controller Type

To change the SCSI controller type on a VMware-based appliance to VMware Paravirtual: 

1. Finish the installation and power on the ESN system. 

2. Ensure that the ESN system is running. (Log in as the ESN administrator, create a user, and log 
in as that user.)

3. Shut down each appliance in the ESN system. (For information about how to safely shut down 
an appliance, see “Shutting Down and Restarting the Micro Focus Appliance” in the ESN 1.0: 
Administrative UI Reference.)

4. In VMware, change the controller to VMware Paravirtual.

5. Power on each appliance in the ESN system.
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G GTroubleshooting the ESN 
Installation and Upgrade

 “Unable to Access a Newly Installed Appliance” on page 109

 “The Upgrade Dialog Box Is Not Displayed during an Upgrade” on page 109

 “Rolling Back to the Previous Version after an Unsuccessful Upgrade” on page 110

Unable to Access a Newly Installed Appliance
If you are unable to access a newly installed appliance and you need to change appliance settings, 
such as the IP address, use the VACONFIG utility from the ESN command prompt. 

For more information, see “Using VACONFIG to Modify Network Information” in the ESN 1.0: 
Maintenance Best Practices Guide.

The Upgrade Dialog Box Is Not Displayed during an 
Upgrade

The following dialog box should be displayed when powering on the new appliance.

If it is not displayed, the data storage location was not successfully copied or attached to the new 
ESN system. Begin the upgrade process again and ensure that you have configured the new ESN 
system to point to the data storage location of the source ESN system.
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Rolling Back to the Previous Version after an 
Unsuccessful Upgrade

You can roll the ESN system back to the previous version if the upgrade is unsuccessful.

 “Rolling Back a Small or Non-Clustered ESN System” on page 110

 “Rolling Back a Clustered ESN System” on page 110

Rolling Back a Small or Non-Clustered ESN System

You should have created a copy of the data storage location (/vastorage) to be used in the new ESN 
system (as described in “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 85).

If you experience complications when upgrading the ESN system, your existing ESN system is still 
intact and you are able to power it on at any time. 

Rolling Back a Clustered ESN System

A clustered ESN system (multiple ESN appliances) consists of not only a data storage location (/
vastorage), but also shared storage (/vashare).

 “Rolling Back the Data Storage Location (/vastorage)” on page 110

 “Rolling Back the Shared Storage Location (/vashare)” on page 110

Rolling Back the Data Storage Location (/vastorage)

You should have created a copy of the data storage location (/vastorage) to be used in the new ESN 
system (as described in “Copying Each Appliance’s /vastorage Disk (Disk 2)” on page 85).

If you experience complications when upgrading the ESN system, the data storage location of your 
existing ESN system is still intact.

Rolling Back the Shared Storage Location (/vashare)

After an unsuccessful upgrade, you can roll back the shared storage location (/vashare) to the 
previous version by reconfiguring clustering on the ESN server:

1 On the ESN appliance that you are rolling back to, log in as the ESN administrator.

https://ip_address:9443

Replace ip_address with the IP address of your ESN appliance.

2 Sign in to the ESN appliance using the vaadmin user and the password that you set during 
installation.

The Micro Focus ESN Appliance landing page is displayed.

3 Click the ESN Server Configuration  icon. 

4 Click Clustering.

5 In the Server Address field, add the port number to the server address of each search index 
appliance.

For example, change 172.17.2.2 to 172.17.2.2:11211
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H HThird-Party Materials

 “Growl License” on page 111

 “Oracle Outside In Technology” on page 112

 “ANTLR 3 License” on page 112

 “Colt License Agreement” on page 113

 “Dom4j License” on page 113

 “iCal4j License” on page 114

 “ICU4J license (ICU4J 1.3.1 and later)” on page 114

 “JAXEN License” on page 115

 “Jung” on page 115

 “ASM” on page 116

 “Firebug Lite” on page 117

Growl License
Copyright (c) The Growl Project, 2004-2011

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 

 Neither the name of Growl nor the names of its contributors may be used to endorse or promote 
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 
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Oracle Outside In Technology
Oracle shall inform you of any notices and other instructions that are related to third party 
components (including open source software) that are included in a program and/or hardware and 
that Oracle is required to distribute with such programs and/or hardware. These notices and other 
instructions shall be provided to you in at least one of the following ways, at Oracle’s sole discretion: 
(a) automatically installed with the programs or in the installation details; (b) in the program 
documentation; (c) in the readme files or notice files; or (d) via a supplemental list. You shall comply 
with all instructions related to third party software components (including open source software). If 
you reproduce the programs, operating system and/or integrated software, you shall reproduce all 
third party notices in an appropriate location in the reproduction and/or in its related documentation 
and include any associated source code (to the extent such source code is provided by Oracle), as 
required by the applicable notices or as otherwise directed by Oracle?.

PDF documents with complete information about the use of Oracle technology in ESN are located in 
the following directory on the ESN server:

/opt/novell/ESN/stellent-converter

ANTLR 3 License
Copyright (c) 2003-2008, Terence Parr

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 

 Neither the name of the author nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 
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Colt License Agreement
Packages cern.colt*, cern.jet*, cern.clhep 

Copyright (c) 1999 CERN - European Organization for Nuclear Research.

Permission to use, copy, modify, distribute and sell this software and its documentation for any 
purpose is hereby granted without fee, provided that the above copyright notice appear in all 
copies and that both that copyright notice and this permission notice appear in supporting 
documentation. CERN makes no representations about the suitability of this software for any 
purpose. It is provided “as is” without expressed or implied warranty. 

Packages hep.aida.* 

Written by Pavel Binko, Dino Ferrero Merlino, Wolfgang Hoschek, Tony Johnson, Andreas 
Pfeiffer, and others. Check the FreeHEP home page for more info. Permission to use and/or 
redistribute this work is granted under the terms of the LGPL License, with the exception that any 
usage related to military applications is expressly forbidden. The software and documentation 
made available under the terms of this license are provided with no warranty.

Dom4j License
Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.

Redistribution and use of this software and associated documentation (“Software”), with or without 
modification, are permitted provided that the following conditions are met: 

1. 1.Redistributions of source code must retain copyright statements and notices. Redistributions 
must also contain a copy of this document.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 

3. The name “DOM4J” must not be used to endorse or promote products derived from this 
Software without prior written permission of MetaStuff, Ltd. For written permission, please 
contact dom4j-info@metastuff.com.

4. The name “DOM4J” must not be used to endorse or promote products derived from this 
Software without prior written permission of MetaStuff, Ltd. For written permission, please 
contact dom4j-info@metastuff.com. 

5. Products derived from this Software may not be called “DOM4J” nor may “DOM4J” appear in 
their names without prior written permission of MetaStuff, Ltd. DOM4J is a registered trademark 
of MetaStuff, Ltd. 

6. Due credit should be given to the DOM4J Project (http://www.dom4j.org).

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS “AS IS”' AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR 
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.
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iCal4j License
Copyright (c) 2008, Ben Fortuna

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

 Neither the name of Ben Fortuna nor the names of any other contributors may be used to 
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

ICU4J license (ICU4J 1.3.1 and later)
COPYRIGHT AND PERMISSION NOTICE

Copyright (c) 1995-2001 International Business Machines Corporation and others

All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, including 
without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the 
Software, and to permit persons to whom the Software is furnished to do so, provided that the above 
copyright notice(s) and this permission notice appear in all copies of the Software and that both the 
above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. 
IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE 
LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR 
ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, 
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, 
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS 
SOFTWARE.
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Except as contained in this notice, the name of a copyright holder shall not be used in advertising or 
otherwise to promote the sale, use or other dealings in this Software without prior written 
authorization of the copyright holder. 

JAXEN License
Copyright (C) 2000-2002 Bob McWhirter & James Strachan.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and 
the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, 
and the disclaimer that follows these conditions in the documentation and/or other materials 
provided with the distribution.

3. The name “Jaxen” must not be used to endorse or promote products derived from this software 
without prior written permission. For written permission, please contact license@jaxen.org.

4. Products derived from this software may not be called “Jaxen,” nor may “Jaxen” appear in their 
name, without prior written permission from the Jaxen Project Management (pm@jaxen.org).

In addition, we request (but do not require) that you include in the end-user documentation provided 
with the redistribution and/or in the software itself an acknowledgement equivalent to the following:

“This product includes software developed by the Jaxen Project (http://www.jaxen.org).”

Alternatively, the acknowledgment may be graphical using the logos available at http://
www.jaxen.org.

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE Jaxen 
AUTHORS OR THE PROJECT CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, 
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Jaxen 
Project and was originally created by bob mcwhirter (bob@werken.com) and James Strachan 
(jstrachan@apache.org). For more information on the Jaxen Project, please see http://
www.jaxen.org.

Jung
THE JUNG LICENSE

Copyright (c) 2003-2004, Regents of the University of California and the JUNG Project

All rights reserved.
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Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

 Neither the name of the University of California nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ASM
Copyright (c) 2000-2005, INRIA, France Telecom

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

 Neither the name of the copyright holders nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Firebug Lite
Copyright (c) 2006-2007, Joe Hewitt

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:

 Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer.

 Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the 
distribution.

 Neither the name of the copyright holders nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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